Document Identification

<table>
<thead>
<tr>
<th>Revision</th>
<th>Version 1.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compiled By:</td>
<td>Tracy Hudson &amp; Allison King</td>
</tr>
<tr>
<td>Signature:</td>
<td>Original signed</td>
</tr>
<tr>
<td>Issue Date:</td>
<td>29 November 2005</td>
</tr>
</tbody>
</table>

Authorities

<table>
<thead>
<tr>
<th>Name</th>
<th>Signature</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Manager</td>
<td>Sue Hickton</td>
<td>Original signed</td>
</tr>
</tbody>
</table>

Document History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Author</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>29-11-2005</td>
<td>1.0</td>
<td>Tracy Hudson &amp; Allison King</td>
<td>Compilation for Training</td>
</tr>
</tbody>
</table>
Table of Contents

Oracle 11i Implementation Project .................................................................................. 1-1
  Why are we re-implementing Oracle? .............................................................................. 1-3
  New Functionality in 11i ................................................................................................. 1-4
  Course Structure ........................................................................................................... 1-5

Oracle 11i - Abbreviations ................................................................................................. 2-1
  Oracle 11i - Abbreviations .............................................................................................. 2-2

Oracle 11i - Inquiries Course Objectives ......................................................................... 3-1
  Oracle 11i – Inquiries Course Objectives ...................................................................... 3-2
  Course Objectives .......................................................................................................... 3-3

Oracle 11i - Searching for Data Using Forms ................................................................ 4-1
  Oracle 11i - Searching for Data Using Forms ................................................................. 4-2
  Lesson Objectives ........................................................................................................... 4-3
  How to Use Find Mode .................................................................................................. 4-4
  Using the Find Window .................................................................................................. 4-5
  Specifying Complex Search Criteria ............................................................................ 4-6
  Using Query Mode .......................................................................................................... 4-7
  Query Operators ............................................................................................................. 4-8
  Query vs Find .................................................................................................................. 4-9
  Retrieved Records .......................................................................................................... 4-10
  Guided Demonstration .................................................................................................. 4-11
    Guided Demonstration - Searching for Data Using Forms ........................................... 4-12
    Practice - Searching for Data Using Forms .................................................................. 4-13
    SolutionPractice - Searching for Data Using Forms ................................................... 4-14
  Summary ....................................................................................................................... 4-16

Oracle 11i - General Ledger Inquiries ............................................................................ 5-1
  Oracle 11i - General Ledger Inquiries .......................................................................... 5-2
  Objectives ....................................................................................................................... 5-3
  Agenda ............................................................................................................................ 5-4
  Online Inquiry ................................................................................................................. 5-5
  Overview ........................................................................................................................ 5-6
  Agenda ............................................................................................................................ 5-7
  Performing an Account Inquiry ...................................................................................... 5-8
  Reviewing Balances in an Account Inquiry .................................................................... 5-10
  Drilling Down to Journal Detail ..................................................................................... 5-11
  Reviewing Variances between Account Balance Types ................................................ 5-12
  Guided Demonstration .................................................................................................. 5-13
    Guided Demonstration - Inquire on a General Ledger Account ................................... 5-14
    Practice - Inquire on a General Ledger Account ......................................................... 5-15
    Solution: Practice - Inquire on a General Ledger Account .......................................... 5-16
  Agenda ............................................................................................................................ 5-17
  Performing a Journal Inquiry .......................................................................................... 5-18
  Drilling Down to Subledger Applications ....................................................................... 5-19
  T-Accounts ..................................................................................................................... 5-20
  Display options available while viewing T-Accounts and Activity Summary .................. 5-22
  Guided Demonstration .................................................................................................. 5-24
    Guided Demonstration - Inquire on a General Ledger Journal ................................... 5-25
    Practice - Inquire on a General Ledger Journal ........................................................... 5-26
    SolutionPractice - Inquire on a General Ledger Journal ........................................... 5-27
  Agenda ............................................................................................................................ 5-28
  Self-Service Account Analysis and Drilldown ............................................................... 5-29
  Guided Demonstration .................................................................................................. 5-31
    Guided Demonstration - General Ledger Self-Service Account Analysis and Drilldown .... 5-32
    Practice: General Ledger Self-Service Account Analysis and Drilldown ....................... 5-33
    Solution - Practice: General Ledger Self-Service Account Analysis and Drilldown ........ 5-34
  Summary ....................................................................................................................... 5-35
<table>
<thead>
<tr>
<th>Oracle 11i - Receivables Inquiries</th>
<th>6-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle 11i - Receivables Inquiries</td>
<td>6-2</td>
</tr>
<tr>
<td>Objectives</td>
<td>6-3</td>
</tr>
<tr>
<td>Agenda</td>
<td>6-4</td>
</tr>
<tr>
<td>View Customer Contact Information</td>
<td>6-5</td>
</tr>
<tr>
<td>Guided Demonstration</td>
<td>6-6</td>
</tr>
<tr>
<td>Guided Demonstration - View Customer Contact Information</td>
<td>6-7</td>
</tr>
<tr>
<td>Practice - View Customer Contact Information</td>
<td>6-8</td>
</tr>
<tr>
<td>Solution – View Customer Contact Information</td>
<td>6-9</td>
</tr>
<tr>
<td>Agenda</td>
<td>6-10</td>
</tr>
<tr>
<td>Viewing Customer Account Information</td>
<td>6-11</td>
</tr>
<tr>
<td>Viewing Calls to Customers</td>
<td>6-13</td>
</tr>
<tr>
<td>Viewing Account Balances by Aging Bucket</td>
<td>6-14</td>
</tr>
<tr>
<td>Account Overview</td>
<td>6-16</td>
</tr>
<tr>
<td>Account Details</td>
<td>6-18</td>
</tr>
<tr>
<td>Transaction Overview</td>
<td>6-20</td>
</tr>
<tr>
<td>Viewing Balances</td>
<td>6-22</td>
</tr>
<tr>
<td>Guided Demonstration</td>
<td>6-24</td>
</tr>
<tr>
<td>Guided Demonstration - View Customer Account Information</td>
<td>6-26</td>
</tr>
<tr>
<td>Practice - View Customer Account Information</td>
<td>6-27</td>
</tr>
<tr>
<td>SolutionPractice - View Customer Account Information</td>
<td>6-28</td>
</tr>
<tr>
<td>Summary</td>
<td>6-29</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Oracle 11i - Payables Inquiries</th>
<th>7-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle 11i – Payables Inquiries</td>
<td>7-2</td>
</tr>
<tr>
<td>Objectives</td>
<td>7-3</td>
</tr>
<tr>
<td>Agenda</td>
<td>7-4</td>
</tr>
<tr>
<td>Supplier Inquiry</td>
<td>7-5</td>
</tr>
<tr>
<td>Suppliers – General Tab</td>
<td>7-7</td>
</tr>
<tr>
<td>Suppliers – Classification Tab</td>
<td>7-8</td>
</tr>
<tr>
<td>Suppliers – Control Tab</td>
<td>7-9</td>
</tr>
<tr>
<td>Suppliers – Payment Tab</td>
<td>7-11</td>
</tr>
<tr>
<td>Supplier Site – General Tab</td>
<td>7-13</td>
</tr>
<tr>
<td>Supplier Site – Contacts Tab</td>
<td>7-15</td>
</tr>
<tr>
<td>Supplier Site – Payment Tab</td>
<td>7-16</td>
</tr>
<tr>
<td>Supplier Site – Tax Reporting Tab</td>
<td>7-19</td>
</tr>
<tr>
<td>Guided Demonstration</td>
<td>7-20</td>
</tr>
<tr>
<td>Guided Demonstration - Execute a Supplier Inquiry</td>
<td>7-21</td>
</tr>
<tr>
<td>Practice - Execute a Supplier Inquiry</td>
<td>7-22</td>
</tr>
<tr>
<td>Solution – Execute a Supplier Inquiry</td>
<td>7-24</td>
</tr>
<tr>
<td>Agenda</td>
<td>7-27</td>
</tr>
<tr>
<td>Invoice Inquiry - Overview</td>
<td>7-28</td>
</tr>
<tr>
<td>Invoice Inquiry</td>
<td>7-29</td>
</tr>
<tr>
<td>Calculating Balance Owed Window</td>
<td>7-30</td>
</tr>
<tr>
<td>Invoices Window</td>
<td>7-33</td>
</tr>
<tr>
<td>Invoices – General Tab</td>
<td>7-34</td>
</tr>
<tr>
<td>Invoices – Holds Tab</td>
<td>7-36</td>
</tr>
<tr>
<td>Invoices – View Payments Tab</td>
<td>7-38</td>
</tr>
<tr>
<td>Invoices – Scheduled Payments Tab</td>
<td>7-40</td>
</tr>
<tr>
<td>Invoices – View Prepayment Applications Tab</td>
<td>7-42</td>
</tr>
<tr>
<td>Invoices – Overview Window</td>
<td>7-43</td>
</tr>
<tr>
<td>Invoices – View Accounting</td>
<td>7-45</td>
</tr>
<tr>
<td>Invoices – Distributions Window</td>
<td>7-46</td>
</tr>
<tr>
<td>Guided Demonstration</td>
<td>7-48</td>
</tr>
<tr>
<td>Guided Demonstration - Execute an Invoice Inquiry</td>
<td>7-49</td>
</tr>
<tr>
<td>Practice - Execute an Invoice Inquiry</td>
<td>7-50</td>
</tr>
<tr>
<td>Solution – Execute an Invoice Inquiry</td>
<td>7-52</td>
</tr>
<tr>
<td>Agenda</td>
<td>7-54</td>
</tr>
<tr>
<td>Payment Inquiry</td>
<td>7-55</td>
</tr>
<tr>
<td>Payments Window</td>
<td>7-56</td>
</tr>
<tr>
<td>Payment Overview</td>
<td>7-57</td>
</tr>
</tbody>
</table>
Oracle 11i - Inquiries Course Table of Contents
Revision V 1.0

Oracle 11i - Purchasing Inquiries ................................................... 8-1
Oracle 11i – Purchasing Inquiries .................................................. 8-2
Objectives .................................................................................. 8-3
Agenda ...................................................................................... 8-4
Requisition Inquiry ................................................................. 8-5
Requisition Headers Summary Window .................................... 8-7
Requisition Lines Summary Window ......................................... 8-9
Requisitions Distributions Summary Window ......................... 8-11
Guided Demonstration ............................................................... 8-12
  Guided Demonstration - Execute a Requisition Inquiry .......... 8-13
  Practice - Execute a Requisition Inquiry .............................. 8-14
  Solution – Execute a Requisition Inquiry ............................ 8-16
Agenda ...................................................................................... 8-18
Purchase Order Inquiry .......................................................... 8-19
Purchase Orders Headers Summary Window ......................... 8-21
Purchase Order Lines Summary Window ................................. 8-23
Purchase Order Shipments Summary Screen ......................... 8-25
Purchase Order Distributions Summary Window ..................... 8-27
Guided Demonstration ............................................................... 8-29
  Guided Demonstration - Execute a Purchase Order Inquiry .... 8-30
  Practice - Execute a Purchase Order Inquiry ....................... 8-31
  Solution – Execute a Purchase Order Inquiry ..................... 8-33
Summary ................................................................................... 8-36

Oracle 11i - Additional Inquiry Features ........................................... 9-1
Oracle 11i - Additional Inquiry Features .................................... 9-2
Objectives ................................................................................ 9-3
Park a document on the Navigator ........................................... 9-4
Folder Tools ........................................................................... 9-6
Summary .................................................................................. 9-7

Oracle 11i - Where to from here ................................................... 10-1
Where to from here ................................................................. 10-3
Oracle 11i Implementation Project
Why are we re-implmenting Oracle?

- Current Oracle system is not supported
- Chart of Accounts has been re-implemented
- Chance to implement new functionality
- Interfaces being re-written

Interfaces are the transfer of data from one system i.e. Callista to another system i.e. Oracle, which happens automatically. This allows the Oracle system to be used as the core financial system for the University.
New Functionality in 11i

- **Payables** – Redesigned Invoice entry screen, XML invoices and payments, email remittance advice
- **Cash Management** – new module for bank reconciliations
- **Fixed Assets** – iAssets, Asset maintenance, transfer Assets by category, Rollback/Recreate journal entries
- ** Receivables** – Improved User Interface, Invoice preview and reprint, XML invoices, Credit Management
- **General Ledger** – XML Publisher, eJournals, Enhanced Drilldown & T Accounts, Automatic Journal Reversal, Web based account inquiries
You will be attending this Oracle 11i training session to enhance your understanding of the new finance system.

The above diagram shows the prerequisite training you will be attending, plus non-mandatory training sessions that we recommend.
Some common abbreviations used in this course:-

- (M) = Menu
- (B) = Button
- (Help) = Oracle Online Help Screens
- (N) = Navigator
- (I) = Icon
- (T) = Tab
- LOV = List of Values
- (H) = Hyperlink

Common Abbreviations
During this training session and future training sessions you will be enrolled in you will come across some standard menu path abbreviations that are used through the Oracle 11i documentation.
To assist you in achieving the most effective learning outcomes, the chapters in this course are laid out as follows:

1. Chapter overview
2. Guided Demonstration
3. Practice
Course Objectives

After this course, you should be able to:

- Search for data within forms
- Search for data in General Ledger
- Search for data in Receivables
- Search for data in Payables
- Search for data in Purchasing
- Use additional Inquiry Features

Oracle 11i – Inquiries Course Overview

This course discusses the features of searching and querying data within Oracle 11i Applications. You will learn to effectively interrogate data in the Oracle modules and export this data to Excel.

This course builds on the knowledge you have gained by attending the Oracle 11i Navigation and Chart of Accounts training sessions.
Oracle 11i - Searching for Data Using Forms
Lesson Objectives

After this lesson, you should be able to:

- Use the Find window to perform a search
- Search for data using Query By Example
- Include wildcards and query operators in your search criteria
- Identify the difference between Find and Query mode
- Review records retrieved from a search

Lesson Overview

Oracle Applications provides you with easy-to-use search capabilities to access application information. This lesson demonstrates how to retrieve, view, and analyse data within Oracle Applications forms.
How to Use Find Mode

1. Click on the Find icon on the toolbar
2. Specify your search criteria
3. Click the Find button on the Form
4. Review the retrieved records

Using Find Mode

To search for records in your current window, use the Find window. The Find window contains fields for entering search criteria. These fields are specific to the current window and often validate the search criteria you enter against a list of valid values.
Using the Find Window

1. (M) View > Find or click (I) Find
2. Enter your search criteria in the appropriate fields of the Find window. If a field does not provide a list of values for you to choose from, you can enter wildcard characters (% and _) in the search phrase. You cannot, however you are unable to use characters such as >, <, in the Find window.
3. (B) Find to find matching records.
4. (B) Clear to clear the current search criteria from the Find window so you can enter new search criteria.
Specifying Complex Search Criteria

To retrieve a group of records based on more sophisticated search criteria than the Find mode can achieve, you can use Query mode to specify complex search criteria in most of the fields of your current window.

The search criteria can include specific values, phrases containing wildcard characters, and phrases containing query operators to help you pinpoint the data of interest.

In addition, if you do not actually need to retrieve the records in Query mode, but only want to know how many records match your search criteria, you can perform a query count to save yourself time.
Using Query Mode

How to Use Query Mode

1. (M) View > Query By Example > Enter
2. Enter search criteria
3. (M) View > Query By Example > Run, or
4. (M) View > Query By Example > Cancel

How to Obtain a Query Count

1. Perform steps 1 and 2 above.
2. (M) View > Query By Example > Count Matching Records to display the number of records a Query By Example search would retrieve.
Query Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal to</td>
<td>=Oracle</td>
</tr>
<tr>
<td>!=</td>
<td>Not equal to</td>
<td>!=Janet'</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
<td>&gt;99.1</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
<td>&gt;=55</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
<td>&lt;1000.00</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
<td>&lt;=100</td>
</tr>
<tr>
<td>#BETWEEN</td>
<td>Between two values</td>
<td>#BETWEEN 1 and 100</td>
</tr>
</tbody>
</table>

Using Query Operators and Wildcard Characters

You can use any of the query operators listed in the table shown in the slide. You can also use the percent “%” wildcard character to represent any character or group of characters. For example, use “Manuf%” to represent Manufacturing, Manufacturer, and so on. You can also use the underline “_” character to represent any single character. For example, “Product_” can represent ProductA, or Product1.
Query vs Find

**Query Mode**
- In Query mode, you can use the menu bar to access a query, or you can use keyboard shortcuts, [F11] to enter a query, and [Ctrl] + [F11] to execute a query.
- You can use the existing window to prepare your search criteria for the query. You can enter specific information into any field to narrow your search.
- When using wildcards to prepare your search criteria, you can use all query operators to narrow your search.
- In query mode, you can check to see how many records match your criteria even before retrieving the data that matches your query.

**Find Mode**
- In Find mode, you can use the menu bar to access the Find window, or you can click the icon on the Toolbar.
- You use a new window, the Find window, to prepare your search criteria.
- The list of values is available in many fields in Find mode.
- The Query Count feature is not available in Find mode.
Retrieved Records

After a search, Oracle Applications retrieves any records that matched your search criteria. Always enter the most selective search criteria that you can.

How to Review Retrieved Records:

Use the scroll bar to view additional records currently not visible on the screen in a window.

- (M) View > Record First to see the first record.
- (M) View > Record Last to see the last record.

Note: Scrolling through records and using the Record Last command uses significant system resources. Avoid this by entering selective search criteria.
This demonstration covers how to search for records using the Find and Query functionality

(N) ECU Generic Reporting and Inquiries > Inquiries > Journal (GL)
Guided Demonstration - Searching for Data Using Forms

In this demonstration you will show how to search for data.

Responsibility: ECU Generic Reporting and Inquiries

1. (N) ECU Generic Reporting and Inquiries > Journal (GL)

2. Use Find Mode
   – If you are logging in to Oracle from the E-Business log in screen, find screen will automatically appear.
   – If you are already in the Application in an entry screen, click the (I) Find (the torch button).
   – Enter “Unposted” in the Posting Status field. It is advisable to enter parameters to reduce the search criteria reduced.
   – (B) Find.

3. Use Query Mode
   – If you are in an entry screen, (M) View > Query By Example > Enter, enter search criteria, again it should be emphasized the criteria should be added to reduce the number of criteria being returned.
   – Enter “Un%” in the Batch Status column. By using the % (wildcard) it will bring back any batch with a Batch Status starting with Un.
   – (M) View > Query By Example > Run.

3. If you are in an entry screen you are also able to use shortcuts. In the Journals (GL) entry screen you can click F11, enter your search criteria, Ctrl-F11 will bring the search results up. This is a faster way of accessing your search requirements.
Practice - Searching for Data Using Forms

Overview

In this practice, you will search for data using a variety of methods as discussed earlier in the chapter.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- Username = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Journal (GL).

2. Use some of the searching methods to locate journals i.e.
   - Batch Status = Unposted
   - Source = Receivables
   - Category = Miscellaneous
   - Journal = XX_Training Journal 01
Solution - Searching for Data Using Forms

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Journals (GL).

2. In the Find window, enter different types of search criteria
   – Batch Status = Unposted, or
   – Source = Receivables, or
   – Category = Miscellaneous, or
   – Journal = XX_Training Journal 01

3. (B) Find

4. In the Entry window, use the F11 (shortcut keys) to type in searches using the wildcards and query operations i.e. %, <, > as learnt during the lesson

5. Ctrl-F11 will return your queries.

6. Navigator
   – (I) Navigator
In this lesson you should have learned about:

- Using the Find window to perform a search
- Searching for existing data in an application using Query By Example
- Including wildcards and query operators in your search criteria
- Understanding whether to use Find or Query mode
- Reviewing records retrieved from a search
Objectives

After completing this lesson, you should be able to:

- Inquire on an account
- Inquire on a journal
- Use the Self-Service Account Analysis and Drilldown functionality
Agenda

- Overview of the Account Inquiry window
- Inquire on an account
- Inquire on a journal
- Inquire using the Self-Service Account Analysis and Drilldown
You can drill down to subledger transactions enabling further transactional analysis.

General ledger provides you with both self-service and forms-based account and journal inquiry functionality. Within General Ledger, you can use the inquiry functionality to drill from summary account balances to detail balances, and to complete journal entries. You can drill to any underlying Oracle subledger transactions for further accounting entry analysis, including transactions from Receivables, Payables, Assets (except depreciation) and Purchasing.

During the drill down process, you can view your accounting entries in a T-Account format or a Summary Account format. The T-Account format eases accounting analysis by graphically displaying your accounting entry in T-Accounts for both summary and detail financial information.
Overview

The above flow illustrates General Ledger’s online account and journal inquiry features, and General Ledger’s related drilldown capabilities.

**Account:** Review specific account balances and compute variances from a secondary balance type.

**Journal:** Review information about specific journal batches and journal entries.

After performing an online query, you can drill down to see additional details, for example:-

**Summary to Detail:** After querying a summary account, drill down to the detail balances that comprise the summary account balance.

**Detail Balances to Journals:** From any detail account balance you can drill down to the journals that contribute to the balance. If you drill down to summary journals, you can drill down further to detail journals.

**Journals to Subledger Details:** From detail journals you can drill down further to see the subledger transactions that comprise the journal. You can also view subledger transactions as balanced journal entries or in the form of T-Accounts.
Agenda

- Overview of the Account Inquiry window
- **Inquire on an account**
- Inquire on a journal
- Inquire using the Self-Service Account Analysis and Drilldown
Performing an Account Inquiry

Perform an Account Inquiry to view actual and/or budget account balances:

- Compute variances between two balance types
- Drill down to see the journal entries that comprise your account balances
- Drill down to see the subledger transactions that comprise the journals that contain your account balances
- View journal and subledger transaction information as balanced accounting entries or in a T-Accounts format.

To perform an Account Inquiry:

1. If you are logging into Oracle you need to select: (N) ECU General Reporting and Inquiries > Inquiries > Account (GL) (your responsibility may be different in the Production environment)
2. If you are already in General Ledger, (I) Navigator > Inquiries > Account (GL).
3. Enter the range of Accounting Periods to include in your inquiry.
4. Specify the currency to include in the inquiry. You cannot use the (B) Show Variance in your Account Inquiry if you choose to inquire on all currencies. Note: foreign currency functionality is new to Oracle 11i.
5. Choose the Primary Balance Type tabbed region (actual).
6. Specify whether you want to see Actual or Budget, you don’t need to select this option if you are viewing actual balances only.

7. Choose a display and precision factor i.e. units, thousands, millions, billions.

8. (Optional) specify the Secondary Balance Type (i.e. budget) if you want to compute variances. To do this, choose the Secondary Balance Type tabbed region. The secondary balance type must be different than the primary balance type.

9. Specify the Account(s) you want to query.

10. Choose the button related to the type of account information you want to see.

**Account information buttons:-**

**Show balances:** to review balances for the current account based on your inquiry criteria.

**Show Journal Details:** to see the journal entry activity for the current account based on your inquiry criteria. This button is not available if you choose to inquire on translated balances.

**Show Variances:** to see a variance calculation between the primary balance type you chose for the inquiry and a secondary balance type. This button is not available if you choose to inquire on all currencies.
Reviewing Balances in an Account Inquiry

Overview

When you perform an account inquiry you can review the account balances during the period you specify. For any account inquiry, you can view account balances in their entered currency as well as translated (or converted) to your functional currency.

To review balances for an account:-

1. Choose the Show Balances button from the Account Inquiry window.

   You see information for each accounting Period and Currency in your selection criteria, including the Period To Date (PTD) and Year To Date (YTD) balances for your summary or detail account.

   If you are performing the inquiry for a single foreign currency using the Entered Currency type, the PTD and YTD balances include only amounts from journals entered in the foreign currency. You also see the Converted PTD and YTD amounts, which are the functional currency equivalents of the foreign currency amounts.
You can drill down from an account inquiry to view the details of journals.

To review journal information:-
1. Select the Journal you wish to review.
2. (B) Show Full Journal, to review all Journals Lines that relate to that Journal.
3. (B) Drilldown, to review the sub-ledger information. This button only appears if the journal originated from an Oracle subledger application.
4. (B) Detail Balances, to return to the Detail Balances window.
Reviewing Variances between Account Balance Types

When you perform an account inquiry, you can compare the primary balance type (e.g. Actual) to a secondary balance type (e.g. Budget), and compute the variance between them. Variances are calculated: Variance = Primary Balance Type – Secondary Balance Type.

To review variance information:-

1. General Ledger displays a row for each accounting period in the range you defined in the account inquiry criteria. You see a column for the primary and secondary balance types, and the variance between the two balances.

2. Choose the appropriate tabbed region to view Period-to-date, Quarter-to-date, Year-to-date and Project-to-date balances and their variances.

3. Choose the lower-left button (Actual) to open the detail balances window to review the primary balance type balances alone and without the variance calculations. Choose the lower-right button (ECU Budget) to review the secondary balance type balances alone and without the variance calculations.
This demonstration covers how to inquire on an account balance

(N) ECU Generic Reporting and Inquiries > Inquiries > Account (GL)
Guided Demonstration - Inquire on a General Ledger Account

In this demonstration you will see how to inquire on an account.

**Responsibility: ECU Reporting and Inquiries**

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Account (GL)

2. Enter the Accounting Period
   - Nov-2005 (when you go into the screen the current open month defaults. If you want to change it, just type in the months you wish to enquire in).

3. Enter the Accounting Flexfield
   - 99999.0541.0180.SA.01.01
   - When you click on the row under the Accounts heading, you will be prompted with a box to find Accounts, enter your account range in this box.
   - (B) OK

4. (B) Show Balances
   - Explain PTD, YTD etc

5. (B) Show Journal Details
   - Explain the source of Payables, Receivables, General Ledger batches.

6. (B) Show Variance
   - Explain this button is to show the variance between Actual and Budget. **Budgets are currently not set-up in the training environment, so this can’t be demonstrated.**
Practice - Inquire on a General Ledger Account

Overview

In this practice, you will do the following:

- Inquire on a General Ledger Account.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- Username = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Accounts (GL)

2. For the period of Nov-05, inquire on account 99999.0541.0180.SA.01.01

3. Review the Balances
   - What is the PTD balance for Nov-05? ________________________________
   - Does the YTD balance for Nov-05 match? ________________________________

4. Review the Journal Details
   - How many journals make up the balance? ________________________________
   - Are there are Foreign Currency journals? ________________________________
Solution - Inquire on a General Ledger Account

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Accounts (GL)

2. For the period of Nov-05, inquire on account 99999.0541.0180.SA.01.01
   – Enter the Accounting Period: Nov-2005
   – Enter the Accounting Flexfield: 99999.0541.0180.SA.01.01

3. (B) Show Balances
   – What is the PTD balance for Nov-05? $9,575.00
   – Does the YTD balance for Nov-05 match? Yes

4. (B) Show Journal Details
   – How many journals make up the balance? 4
   – Are there any foreign currency journals? 1

5. (M) File > Close Form

   OR F4

   OR (I) > Close Form
Agenda

- Overview of the Account Inquiry window
- Inquire on an account
- **Inquire on a journal**
- Inquire using the Self-Service Account Analysis and Drilldown
Performing a Journal Inquiry

Use the Find Journals window to find journal batches and journal entries. General Ledger displays search results in either the Journal Entry Inquiry or Enter Journals window, depending on how you navigated to the Find Journals window.

This allows you to review detailed information about a batch, a journal entry within that batch, and the detail lines within that entry, drill down from a journal to see the subledger transactions that comprise it and view journal and subledger transaction information as balanced accounting entries or in the form of T-Accounts.

**To perform a Journal Entry Inquiry:**

1. (N) General Ledger > Inquiry > Journal
   
   **Note:** When you first navigate to the Journal Inquiry window from the Oracle E-Business Home Page, the Find Journals window appears automatically.

2. In the Find Journals window, enter query parameters to find the batch or journal you want to review.

3. Once you have entered all of your query parameters, choose Find to run the query. The journal batches or journals that meet your query criteria appear in the Journal Entry Inquiry window.
Drilling Down to Subledger Applications

When you perform an account or journal inquiry in General ledger, you can drill down to view transaction-level detail if the transactions originated in an Oracle subledger application i.e. Payables, Receivables, Assets (except depreciation) and Purchasing.

To review journal detail generated from a Subledger application:-
1. Perform an account or journal inquiry. For an account inquiry, drill down to the journal detail.
2. Review the journal and select a journal detail line where the journal source is a subledger i.e. Payables or Receivables.
3. Choose (M) Tools > Line Drilldown from the menu or alternative (B) Line Drilldown if you are in the Journal Lines. The related subledger’s accounting window appears. From there you can drill down further to view the subledger transaction. You can also view the transaction accounting, as balanced accounting entries or in the form of T-Accounts.
T-Accounts

Use the T-Accounts window to view General Ledger journals or subledger accounting entries in a graphical T-Account format, displayed in the T-Accounts window. The system displays information such as the account, the activity detail, the net activity for the entry, and the account balance.

You can also choose to view journals or subledger accounting entries as an activity summary report, displayed in the Activity Summary window. The window displays information such as the account, the net activity for the entry and the account balance.

T-accounts can be accessed from:

- **General Ledger**: from the Enter Journals, Journals, and Journal Entry Inquiry windows. T-Accounts can also be accessed via an account inquiry, by first drilling down to the Journals window.

- **Oracle Subledger Applications**: from the related subledger's view accounting or accounting windows.

**To view T-accounts:**

1. Choose (M) Tools > T-Accounts from the menu. Alternatively, from some windows you can choose the T-Accounts button.

2. (Conditional) The first time you access T-Accounts, the T-Accounts window appears. You can then specify what window should open the next time you choose to view T-Accounts.
3. To choose how you want the information displayed, click (B) Options. For example, you can choose to view by full accounting flexfield or by segment. You can also choose whether account balances should be displayed.

4. Choose the T-Accounts or Activity Summary button to open the related window.
Display options available while viewing T-Accounts and Activity Summary

T-Accounts

The following display options are available from the Options window:-

**Default Window:** choose which of the three windows appears when you choose to view T-Accounts:-

- **Options:** the Options window
- **T-Accounts:** the T-Accounts window will be displayed
- **Activity Summary:** the Activity Summary window will be displayed

**Organise By:** determines how your accounts are organised in both the T-Accounts and Activity Summary windows:

- **Account:** Each account is displayed as a separate T-Account. The Activity Summary lists accounting activity by account.
- **Segments:** Specify a primary and secondary segment. Each unique combination of the two segments is displayed as a separate account.

**Show in T Accounts:**

- **Account Description:** Yes or No. Yes is the default.
- **Balances:** Yes or No. No is the default. This choice is only for General Ledger journal entries.
• **Entered Amounts**: Yes or No. Yes is the default.
• **Activity**: Yes or No. Yes is the default.

**Show in Activity Summary:**
• **Account Description**: Yes or No. The default is Yes.
• **Balances**: Yes or No. No is the default. This choice is only for General Ledger journal entries.
• **Entered Amounts**: Yes or No. Yes is the default.
• **Columnar display poplist**: Choose Debit and Credit Column to display debits and credits in separate columns. Choose Net Amount Column to display the net amount of debits and credits in one column.

**Note:** You cannot view activity detail in the Activity Summary window.

**Note:** You can only display functional currency amounts in the Activity Summary window.

**Note:** Your display option selections are automatically saved and will be used the next time you view T-Accounts.

**Note:** The Options, T Accounts, and Activity Summary windows are all linked. From any of these windows you can get to the other two by choosing the appropriate button.
Guided Demonstration

This demonstration covers how to inquire on a journal

(N) ECU Generic Reporting and Inquiries > Inquiries > Journal (GL)
Guided Demonstration - Inquire on a General Ledger Journal

In this demonstration you will see how to inquire on a Journal.

Responsibility: ECU Generic Reporting and Inquiries

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Journal (GL).

2. In the Journal Entry search field, you need to enter parameter:-
   – Period = NOV-05

3. (B) Review Journal
   – Must select a journal with a source of Payables or Receivables, other than that, it doesn’t matter which journal you review as this is a demonstration only.
   – Show that you are unable to make any amendments as all the fields are greyed out.

4. (B) T-Accounts.

5. Close the T-Account windows.

6. To drilldown to a subledger you must be in the journal lines area.

7. (B) Line Drilldown.
Practice - Inquire on a General Ledger Journal

Overview

In this practice, you will do the following:

- Inquire on a Journal.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- Username = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

- Do a journal inquiry for Journals in Nov-05 with a source of “Receivables” or “Payables”.
- View journal line details in T-Account format
- Drill down to a subledger
Solution - Inquire on a General Ledger Journal

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Journal (GL)

2. In the Journal Entry search field, you need to enter parameters:-
   – Period = NOV-05

3. (B) Find

4. (B) Review Journal
   – Must select a journal with a source of Payables or Receivables, other than that, it doesn’t matter which journal you review as this is a demonstration only.
   – Show that you are unable to make any amendments as all the fields are greyed out.
   – You must in the journal lines to access (B) Line Drilldown.

5. (B) T-Accounts

6. (B) Line Drilldown

7. Review some of the other journals that are available. Close the journal you are in and you will be returned to the Journal Entry Inquiry screen.

8. (M) File > Close Form
   OR F4
   OR (I) > Close Form
Agenda

- Overview of the Account Inquiry window
- Inquire on an account
- Inquire on a journal
- Inquire using the Self-Service Account Analysis and Drilldown
Self-Service Account Analysis and Drilldown

Use General Ledger’s Account Analysis and Drilldown feature to perform ad hoc queries, query multiple accounts simultaneously, save and reuse frequently used search criteria and customise query result layouts.

This information can be used to allow you to quickly view account balances online without running a report, research discrepancies and create adjusting entries during account reconciliation and period close.

Selecting a Format to Display Inquiry Search Results:-

Before initiating an inquiry from the Account Balances page, specify the search results display format:

1. Period Listing (the default), displays search results with periods stacked vertically.
2. Period Trend, displays search results with periods shown horizontally.

From the displayed search results you can:-

1. Drill up on the Summary Accounts icon to summary balances in the Summary Balances page.
2. Drill down on Summary Accounts to detail balances in the Detail Balances page.
3. Drill down on period-to-date balances to journal lines in the Journal Lines page, and further drill down to subledger details.

**Drilling down to Subledgers from Journal Lines:-**

Whether you drill down to journal lines from summary or detail balances, you can click on a debit or credit amount link in the Journal Lines page to drill down to subledger detail information in the Subledger Details page.

**Conducting a Search:-**

1. The search region displays in the Account Balances page.
2. Select Currency Type. You are able to select two options: Entered and Translated. If you are performing the inquiry for a single foreign currency using the Entered currency type, the Period-to-date and Year-to-date balances displayed include only amounts from journals entered in the foreign currency. Search results also show the Converted Period-to-date and Year-to-date amounts, which are the functional currency equivalents of the foreign currency amounts. If you are performing the inquiry for a single foreign currency using the Translated currency type, search results display Period-to-date and Year-to-date balances translated from your functional currency to the foreign currency. Note: there are no converted Period-to-date and Year-to-date balances.

**Creating, Selecting and Updating Views:-**

1. (B) Create Period Listing View or (B) Create Period Trend View. These buttons are displayed after you choose the (N) New Search. After choosing either button, the Create View page appears. Views created and saved in the Create View page subsequently appear in the View drop-down list in the Views region.
2. To select a View, choose (B) Saved Views. The Views region appears.
3. To include or exclude a View from the View drop-down list in the Views region, choose (B) Personalise. The Personalise Views page appears.

**Exporting Search Results:-**

1. (B) Export.
This demonstration covers how to inquire on an account using the Self-Service Account Analysis and Drilldown functionality.

(N) ECU Generic Reporting and Inquiries > Inquiries > Account Analysis and Drilldown (GL)
Guided Demonstration - General Ledger Self-Service Account Analysis and Drilldown

In this demonstration you will see how to inquire on an account using the self service functionality.

Responsibility: ECU Generic Reporting and Inquiries

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Account Analysis and Drilldown (GL).

2. Run a Period Listing query for:-
   – Enter the Accounting Flexfield
   – From: 99999.0541.0180.SA.01.01
   – To: 99999.0541.0180.SA.06.01
   – Period From: Nov-05
   – Period To: Nov-05

3. (B) Go.

4. Duplicate the query for a Period Trend view

5. Drilldown to the subledger by clicking on any of the underlined figures (this indicates a hyperlink)

6. Export the output to Excel
   – (B) Export
Practice: General Ledger Self-Service Account Analysis and Drilldown

Overview

In this practice, you will do the following:

- Inquire on an Account using the Self-Service Account Analysis and Drilldown view.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- Username = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

1. Using the Period Listing view, inquire on:-
   - From: Accounting Flexfield: 99999.0541.0180.SA.01.01
   - To: Accounting Flexfield: 99999.0541.0180.SA.06.01
   - Period From: Nov-05
   - Period To: Nov-05

3. Drill down to the Subledger.

4. What currencies are the journals? ________________________________

2. Duplicate the query using the Period Listing view.
**Solution - General Ledger Self-Service Account Analysis and Drilldown**

**Responsibility: ECU Generic Reporting and Inquiries**

1. (N) Inquiries > Account Analysis and Drilldown (GL)

2. Select Inquiry Type of Period Listing View

3. Enter the Accounting Flexfield
   - 99999.0541.0180.SA.01.01
   - 99999.0541.0180.SA.06.01

4. Enter the Accounting Period
   - Nov-2005 until Nov-2005

5. (B) Go

6. Click on any of the underlined figures to drill down to the subledger

7. You will see that there are journals for two currencies – what are these currencies
   - USD
   - AUD

8. Do the same inquiry using the Period Trend View

9. Click Home at the top right hand of the screen to return back to the Home Page.
After completing this lesson, you should have learned to:

- Inquire on an account
- Inquire on a journal
- Use the Account Analysis and Drilldown functionality
Oracle 11i - Receivables Inquiries
Objectives

After completing this lesson, you should be able to do the following:

- View customer contact information
- View customer account information
Agenda

- View customer contact information
- View a customer account information
View Customer Contact Information

Receivables lets you view all customer and contact information in an easy to read format.

To view customer information:-
1. (N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Inquiry (AR). Note this menu path may change based on your responsibility.
2. Enter your search criteria, which can be any customer account attribute, then query the customer accounts to view.
3. To view the details of a specific customer account, choose Open. To view all addresses for a specific customer, choose Addresses.

To enter information about existing customer accounts:-
1. If the search produces a potential match, the Match Results window will display all existing parties and customer accounts which match the search criteria. Select the correct party or customer account from the list and choose OK.
2. The Customers - Standard window opens and displays the existing information about the customer. Choose the tab in which you want to enter new information. You can enter customer site information by selecting a specific address and choosing Open.
This demonstration covers how to search for customer contact information

(N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Inquiry (AR)
Guided Demonstration - View Customer Contact Information

In this demonstration you will show how to inquire on a customer to view the contact details.

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Debtor Inquiry (AR).

2. Click in the Customer Number column

3. Locate Customer Oracle Corporation Australia Pty Limited
   
   − Hint: F11, Enter Oracle%, Ctrl-F11

4. (B) Open

5. Review customer address/contact information
   
   − Go through the tabs at the header level that are used in debtor creation:
     - Classification Tab:
       - Profile Class
       - Type
       - Category
     - Go through the tabs at the address level:
       - Business Purposes. Can be Bill-To and/or Ship-To
       - On the Bill-To business purpose, click (B) Open
         - Tax Registration Number
         - Payment Terms
         - Salesperson
     - Communication
     - Contacts
     - Contacts: Roles
     - Profile: Transactions
     - Profile: Document Printing
Practice - View Customer Contact Information

Overview

In this practice, you will do the following:

- Inquire on a customer.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- Username = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Debtor Inquiry (AR).

2. Locate Customer Oracle Corporation Australia Pty Limited

3. Review customer address/contact information
   - How many addresses does the customer have? _____________________________
   - What is the Profile Class? ________________________
Solution – View Customer Contact Information

**View Customer Account Information**

1. (N) Inquiries > Debtor Inquiry (AR).

2. In the Customers – Summary screen search for the Customer Name
   - Hint: F11, enter query Oracle%, Ctrl F11

3. (B) Open

4. Click the first address
   - The customer only has 1 address

5. (B) Open

6. (T) Profile: Transactions
   - Hint: Click on the Arrow at the end of the tabs and select Profile: Transactions
     - Profile Class should be “Trade”

7. Return to Navigator

8. (I) Navigator
Agenda

- View customer contact information
- View a customer account information
Receivables lets you view customer account information in a variety of ways. You can view the total amount overdue for a customer, or view all transactions that are past due. Receivables displays a customer’s current account balance in your functional currency using the most recent exchange rate.

From the Customer Account screen you are able to see a total view of the customers account including past customer correspondence, customer calls, aging of debt, account overview and account details. These screens are view only. If you require information to be amended please contact the Senior Finance Officer-Receivables, Revenue Accounting on extension 2759.

**Note:** Check the display currency box to view additional currency information such as Currency Code.

**Note:** To view each customer’s bill-to location, check the Display Locations box.

**To display a customer’s account information in summary form:**

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Invoice (AR). Note this menu path may change based on your responsibility.
2. Enter selection criteria in the Find Customer Accounts window i.e. Collector, Customer Name, Customer Number.

3. (B) Find.

**Customer Accounts Window Columns Reference:-**

**Average Days Late:** The average number of days late for receipts by customer and currency. This is calculated by \( \text{Average Days Late} = \frac{\text{Sum} (\text{Days Late})}{\text{Total Number of Receipts}} \).

**DSO:** Days Sales Outstanding. This is calculated by \( \text{DSO} = \frac{(\text{Total Outstanding Receivables} / \text{Total Sales Amount for Prior DSO Days}) \times \text{DSO Days}}{\text{Total Sales Amount for Prior DSO Days}} \).

**Past Due Transactions:** The number of past due transactions for this customer.

**Receipts at Risk:** The amount of receipts for this customer that have not yet cleared the bank.
Viewing Calls to Customers

When a customer’s account or payment for a specific transaction is past due, the Senior Finance Officer-Receivables can contact the customer and then record results of their conversation, so that you can review what further collection action is being recommended. The Customer Call window is also used to place amounts in dispute.

To view Calls made to Customers:
1. (N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Invoice (AR).
2. Enter a selection criteria in the Find Customer Accounts window i.e. Collector, Customer Names, Customer Num.
3. (B) Find.
4. (B) Call.
5. You are able to review Calls and follow up actions when contact has been made with customers by the Revenue Accounting team.
Viewing Account Balances by Aging Bucket

Receivables lets you view your customer’s outstanding account balances by Aging Bucket. Aging buckets are time periods.

When you view your customer balances by Aging Bucket, Receivables calculates and displays the total outstanding amount and the credits not aged for unapplied cash, on-account cash and on-account credits.

Receivables selects a transaction for aging if its General Ledger date is before or the same as the current date. Once selected for aging, Receivables uses the following formula to determine the number of days past due for each transaction:

\[(Current\ Date) - (Due\ Date) = Days\ Past\ Due\]

Receivables then groups each transaction into an Aging Bucket based upon the number of days it is past due.

To view Account Balances by Aging Bucket:-

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Invoice (AR).
2. Enter a selection criteria in the Find Customer Accounts window i.e. Collector, Customer Names, Customer Num.
3. (B) Find.
4. Select the account to view.
5. (B) Aging.
6. To modify your display, choose Find from the Query menu, then enter selection criteria i.e. enter the Aging Bucket to use.
7. To view past due transactions within a specific Aging Bucket, select the bucket to view, then choose (B) Account Details.

Aging Window Field References:-

- **Cash Claims**: The total amount of non-invoice related claims for this customer. This type of claim is considered unresolved cash or open receipt credits, similar to on-account cash or unapplied cash. Invoice related claims appear in the Dispute Amount field. If you choose to ‘Summarize’ Open Credits in the Find Aging window, Receivables displays your cash claims amount here.

- **Dispute Amount**: The total amount of this customer’s open balance that is currently in dispute.

- **On-Account Cash**: The total amount of on-account cash for this customer. If you chose to ‘Summarize’ Open Credits in the Find Aging window, Receivables displays your on-account cash amount here.

- **On-Account Credits**: The total amount of open on-account credits and credit memos for this customer. These are open until the entire amount is applied to invoices or debit memos. If you chose to ‘Summarize’ Open Credits in the Find Aging window, Receivables displays your on-account credit amount here.

- **Outstanding Amount**: The receivables balance due, adjusted for all credit items, for this customer. Receivables calculates the adjusted balance for your customer as the outstanding balance minus unapplied cash, on-account cash, on-account credits and cash claims. If you chose to ‘Age’ Open Credits in the Find Aging window, the Adjusted Balance is the same as the Outstanding Balance because Receivables automatically includes your credits in the bucket amounts.

- **Prepayments**: The total amount of prepayment receipts that is currently associated with this customer. Prepayments are not aged, and therefore do not contribute to a customer’s outstanding balance.

- **Pending Adjustments**: The amount of adjustments that are currently pending approval.

- **Receipts At Risk**: The amount of this customer’s receipts that have not yet cleared the bank. You must check the Include Receipts At Risk box in the Find Aging window to view this amount.

- **Unapplied Cash**: The total amount of unapplied cash for this customer. If you chose to ‘Summarize’ Open Credits in the Find Aging window, Receivables displays your unapplied cash amount here.

**Notes**: When you select the Account Details button, these balances may show transactions that are not included in the total displayed on the Accounts Detail window. The Aging window displays items based on General Ledger Date, while the Account Details window does not. You can view more detailed information about a transaction by choosing the Details button.
Account Overview

Receivables lets you view the total number and amount of transactions entered during a specific period of time. For example if you specify Mar-05, Receivables displays the total number and amount of transactions, on time and late payments during that period.

To view Account Overview:-

1.  (N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Invoice (AR).
2.  Enter a selection criteria in the Find Customer Accounts window i.e. Collector, Customer Name, Customer Number.
3.  (B) Find.
4.  (B) Account Overview.
5.  To view information for a different period, select the Period to view.
6.  To view account information for more than one period, select a period, press and hold the Shift key, then select another period. Receivables calculates the Count and Functional Amounts for transactions within the periods you selected.
7.  To view the number and amount of On Time, Late, Non-sufficient Funds and Adjustments for this customer, open (T) Key Indicators.
Account Details

Receivables lets you view detailed or summary information about your transactions that have outstanding balances.

Use the Account Details window to view the status, due date, number of days late, dispute amount, and the balance due for a specific transaction.

To view information for a specified transaction, such as a customer bill-to and ship-to addresses, payment terms, due date, status and invoice lines, choose the Transaction Overview button.

The Account Details window, may show transactions that are not included in the total displayed on the Accounts Detail Aging window. The Aging window displays items based on General Ledger Date, while the Account Details window does not. You can view more detailed information about a transaction by choosing the Details button.

To view detailed information about a customer’s transaction:-

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Invoice (AR).
2. Enter selection criteria in the Find Customer Accounts window i.e. Customer Names, Customer Num.
3. (B) Find.
4. (B) Account Details.
Note: When you navigate to either the Receipts or Transactions workbench from the Account Details window, you cannot view the next transaction by pressing the Down Arrow key. To display the next transaction, return to the Account Details window, select the transaction to view using either the mouse or Down Arrow key, then choose Details again.

Account Details Field Reference

Balance Due: The balance of the transaction. If this item is an invoice or debit memo, the remaining amount is the amount due. If this item is a receipt or on-account credit, the remaining amount is the amount not yet applied to debit items.
Transaction Overview

To view information for a specific transaction, such as customer bill-to and ship-to addresses, payment terms, due date, status and invoice lines, choose the Transaction Overview button.

To review detailed information about a specific transaction:-
1. (N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Invoice (AR).
2. Enter selection criteria in the Find Customer Accounts window i.e. Customer Names, Customer Num.
3. (B) Find.
4. (B) Account Details.
5. Select the transaction to view.
6. (B) Transaction Overview.

The Lines and Transaction total fields in the Transaction Overview window do not include any inclusive or exclusive tax amounts for the transaction you are viewing. However, the Unit Price and Amount fields for the individual transaction lines will include tax if the tax code or tax group for this line is tax inclusive.
When you navigate to the Transactions workbench from the Account Details window, you cannot view the next transaction by pressing the Down Arrow key. To display the next transaction, return to the Account Details window, select the transaction to view using either the mouse or Down Arrow key, then choose (B) Transaction Overview again.
Viewing Balances

Receivables lets you view complete information for a specific transaction in the Balances window. The Balances window displays the original transaction amount, the total amount of receipts, credit memos, and adjustments applied to this transaction.

The Balances window also indicates at what level a receipt or credit was applied to this transaction and the type of adjustments that were created.

Receivables displays the total amount of each action affecting this transaction in the ‘Total’ column and displays how the line and tax balances were affected in the ‘Balance’ row.

By default, the Balances window displays transaction balances in the currency in which they were entered, but you can view amounts in your functional currency by checking the Functional Currency box.

To view current balances for a transaction:

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Invoice (AR).
2. Enter selection criteria in the Find Customer Accounts window i.e. Customer Name, Customer Number.
3. (B) Find.
4. (B) Account Details.
5. Select the transaction to view.
6. (B) Balances.
Activities

Receivables lets you view activities that have been associated to a transaction.

To review activities:-

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Invoice (AR).
2. Enter selection criteria i.e. Customer Name, Customer Number.
3. (B) Find.
4. (B) Account Details.
5. Select the transaction to view.
6. (B) Activities.
This demonstration covers how to search for customer account information

(N) ECU Generic Reporting and Inquiries > Inquiries > Debtor Invoice (AR)
Guided Demonstration - View Customer Account Information

In this demonstration you will see how to review customer account information.

**Responsibility: ECU Generic Reporting and Inquiries**

1. (N) Inquiries > Debtor Invoice (AR).

2. Locate Customer Oracle Corporation Australia Pty Limited

3. Review tabs:-
   - Correspondence
   - Call
   - Aging
   - Account Overview
   - Account Details
   - Activities (under the Account Details Tab)
Practice - View Customer Account Information

Overview

In this practice, you will do the following:

- View a Customer Account.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- Username = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Debtor Invoice (AR).

2. Locate Customer Oracle Corporation Australia Pty Limited.

3. Review the customer account
   - Who is the Collector for this customer?

4. Review the customers aged debt
   - Do they have any debt older than 61 days?

5. Review the customers account overview
   - In Nov-05, do they have any Credit Memo’s?

6. Locate the invoice number 100001421
   - When was this invoice due to be paid and what currency was it in?
Solution - View Customer Account Information

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Debtor Invoice (AR).

2. In the Find Customer Accounts screen, select “Oracle%” in the customer name
   - (B) Find

3. Once you are inside the Customer Accounts screen (above) you may requery the information by selecting the Torch Icon on the toolbar.
   - Scroll across the screen and you will be able to see who the Collector is.
   - Who is the Collector for this customer? Janine Scally

4. (B) Aging
   - You are able to view the Aging debt for the customer.
   - (B) Account Details will take you to a list of the invoices that make up the Aging buckets.
   - Close the Aging screen. You must click the [X] at the top of the Aging screen only. If you click the [X] at the top of the Oracle Applications screen, this will exit you from the system.
   - Do they have any debt older than 61 days? Yes

5. (B) Account Overview
   - Click the Period you want to review, remember that you can Shift+Click for multiple periods.
   - From this screen you see the number of invoices and credit memos that have been raised for particular periods plus the corresponding KPI’s.
   - Close the Account Overview screen. You must click the [X] at the top of the Aging screen only. If you click the [X] at the top of the Oracle Applications screen, this will exit you from the system.
   - In Nov-05, do they have any Credit Memo’s? Yes they have two

6. (B) Account Details
   - Search for the Invoice Number 100001421
   - Place your cursor in the invoice section and F11, enter the invoice number and Ctrl-F11.
   - You are able to see information related to the invoice and also drill down to the Invoice using the (B) Transaction Overview.
   - When was this invoice due to be paid and what currency was it in? The invoice is in AUD and was due for payment 01-Jan-2005
In this lesson, you should have learned how to:

- View customer contact information
- View a customer account information
Oracle 11i - Payables Inquiries

Chapter 7
Objectives

After completing this lesson you should be able to do the following:

- Perform Supplier Inquiries
- Perform Invoice Inquiries
- Perform Payment Inquiries
Agenda

- Perform Supplier Inquiries
- Perform Invoice Inquiries
- Perform Payment Inquiries
Supplier Inquiry

You can find suppliers by using the Find Suppliers window or by entering a query directly into the Suppliers window. In the Find Suppliers window you can enter a wide variety of search criteria, including parent supplier, and payment priority range. You then choose the Find button to navigate to the Suppliers window, where Payables displays all suppliers that match the Find criteria. From the Suppliers window, you can review all information about a supplier.

To perform a Supplier Inquiry:-
1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)

To find a supplier using the Find Suppliers window:-
1. To open the Find Suppliers window from the Suppliers window, either by choosing the Find icon from the toolbar or by selecting Find from the View menu. Enter search criteria directly into the fields. You can enter complex criteria by entering information in several fields.
2. Choose Find to navigate to the Suppliers window, where Payables displays all suppliers that match your search criteria.
Suppliers and Supplier Sites Header Field Reference

**Alternate Address:** An alternate address for the supplier site. This field is for your reference only and is not used by Payables.

**Alternate Name:** An alternate name for the supplier or supplier site. Alternate names are not used unless you enable the Sort by Alternate Fields Payables option.

**Inactive On:** Date on which a supplier or supplier site will no longer appear on a supplier list of values.

**Language:** Language spoken at the site. This value controls the language in which Payables prints the Invalid PO Supplier Notice, Prepayment Remittance Notice and Print Invoice Notice.

**Site Name:** Unique supplier site name that distinguishes the site from a supplier’s other sites. For example, city name or branch name. This name is for your reference when selecting sites from a list of values during purchase order or invoice entry, and will not appear on any correspondence with the supplier. Employee's site names are typically Home or Office.

**Supplier Number:** A unique number that identifies each Supplier.

**Supplier Name:** Unique supplier name. You can update a supplier name at any time.

**ABN:** Australian Business Number. An ABN is entered for a supplier if it is an Australian Business (i.e. not a student, staff or overseas business).
Suppliers – General Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (T) General

**Parent Supplier Name:** Name of supplier’s parent company if supplier is a franchise or subsidiary. The parent company must also be defined as a supplier in the system.

**Number:** Parent supplier number.

**Customer Number:** The number the supplier uses to identify us (ECU). This number appears on the Oracle Purchasing standard purchase order.
Suppliers – Classification Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (T) Classification

**Type:** Type of supplier. The Type is used to group suppliers for reporting purposes. Several supplier reports use Type as a report parameter. You can also define tax recovery rules based on supplier type. You define supplier types in the Oracle Payables Lookups window.

**Employee Name:** The name of an active employee to link an employee to the supplier. There will not be an entry in this field unless you enter Employee as the supplier Type in this region.

**Number:** Employee number of the employee you have associated with the supplier record.

**One Time:** Checked if this is a supplier with whom we do not expect to do repeat business. You can find all one–time suppliers by using the Suppliers Find window.

**SIC:** Standard Industry Code.
Suppliers – Control Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (T) Control

**Invoice Amount Limit**: If an invoice for a supplier site that exceeds the invoice amount limit specified is entered, Payables applies an Amount hold to the invoice during Invoice Validation. The invoice cannot be paid until the hold is released.

**Invoice Match Options**: For purchase order shipments, indicate whether you want to match invoices to purchase orders or to purchase order receipts. This option defaults in the following order and can be overridden at any level.

- Purchase Order – match invoice to purchase order shipments and/or distributions.
- Receipts – match invoices to purchase order receipts.

**Hold All Payments**: The most restrictive supplier site hold. If Hold All Payments is selected for a supplier site, no invoices for the supplier site will be selected for payment during the payment batch or for a Quick payment. No invoices will be paid for the supplier site until the Hold All Payments option is deselected at the supplier site. If the Hold All Payments option is enabled at the supplier site, the Hold field in the Invoices window does not reflect this, because it is a supplier hold, not an invoice hold.
**Hold Unmatched Invoices:** If this option is enabled for a site, then Payables applies a Matching Required hold to an invoice if it has Item type distributions that are not matched to either a purchase order or receipt. Payables applies the hold to the invoice during Invoice Validation. The invoice cannot be paid until the hold is released. The hold can be released by matching the invoice to a purchase order or receipt and resubmitting Invoice Validation, or it can be manually released in the Holds tab of the Invoice Workbench. Payables will not apply a hold if the sum of the invoice distributions by accounting code combination is zero.

**Hold Unvalidated Invoices:** If enabled, Payables automatically applies a Supplier hold to all unvalidated invoices entered for that site, including any invoices you import. Payables applies this hold when you submit Invoice Validation. You can still pay invoices that were entered for the supplier site. You can manually release the Supplier hold in the Hold stab of the Invoice Workbench. Deselect this supplier site option when you no longer want to hold unvalidated invoices for a supplier site.

**Payment Hold Reason:** The reason you are applying an invoice hold to an invoice.
Suppliers – Payment Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (T) Payment

Terms: Payment terms are used to schedule payments for an invoice. The system uses payment terms to automatically calculate due dates, discount dates, and discount amounts for each invoice you enter. The payment terms for a supplier defaults to the supplier site which in turn defaults to the invoices except in the following circumstances:
   - A PO Default or QuickMatch invoice is entered in the Invoice Workbench, in which case the terms default from the purchase order.
   - An invoice record is imported that has payment terms specified on the record, or the import process can derive terms from purchase order matching.

Invoice Currency: The supplier invoice currency is used as a default for new supplier sites you enter. The supplier site invoice currency is used as a default for the Purchasing documents and Payables transactions you enter for a supplier.

Pay Group: Pay Group assigned to a supplier. The default for this field is the Payables option defined for Pay Group. The default can be overwritten during supplier site entry or invoice entry. When a payment batch is created, a specific Pay Group can be chosen to
pay a category of suppliers or invoices in the same payment batch. Examples of Pay
Groups include employees, students, General, Local EFT, Overseas EFT, etc.

**Payment Currency:** The default for Payment Currency in the Suppliers window is the
value entered for supplier Invoice Currency. The can be overwritten only if the Invoice
Currency has associated fixed–rate currencies (for example, euro). The supplier Payment
Currency is used as a default for all new supplier sites entered. The supplier site Payment
Currency is the default for the Payment Currency field in the Invoices window. It is also
the default currency for invoices you create for this supplier site by using Payment on
Receipt, Open Interface Import, and Recurring Invoices.

**Payment Priority:** A number, between 1 (high) and 99 (low), which represents the
priority of payment. The system uses the Supplier Site value to automatically assign a
Payment Priority to an invoice’s scheduled payment(s) during invoice entry.

**Terms Date Basis:** Date from which Payables calculates a scheduled payment for a
supplier. The default is one of the following Payables option you defined for Terms Date
Basis.

- System - When invoices are entered, Payables defaults the system date as the terms
date.
- Goods Received - When invoices are entered, Payables prompts for the date you
received the goods that are included on the invoice were received as the terms date.
- Invoice - When invoices are entered, Payables defaults the invoice date as the terms
date (DEFAULT).
- Invoice Received - When invoices are entered, Payables prompts for the date the
invoice was received as the terms date.

**Always Take Discount:** This option is enabled if Payables is always to take an
available discount for a supplier, regardless of when the invoice is paid.

**Pay Date Basis:** The Pay Date Basis for a supplier determines the pay date for a supplier’s
invoices.

**Payment Method:** The method most frequently used to pay this supplier’s invoices:
- Cheque - Can be paid with a manual payment, a Quick payment, or in a payment
batch.
- Electronic - Electronic payments are paid through the e–Commerce Gateway.
Payables creates a file during payment batch creation. E–Commerce Gateway
payment files are processed through the e–Commerce Gateway and delivered to
your bank to create payments.

**Allow Interest Invoices:** If this option is enabled, Payables calculates interest for the
supplier’s overdue invoices and creates corresponding interest invoices when you pay the
overdue invoices. Payables calculates interest only for invoices that are overdue 365 days
or less. If you enable this option, it is automatically enforced for all of a supplier’s sites.
Payables automatically enables this option in this window if you enabled this option in the
Payables Options window. If this option is not enabled in the Payables Options window,
you cannot enable it here.

**Pay Alone:** If this option is enabled for an invoice, Payables creates a separate payment
for each invoice. If the option is not enabled for an invoice, the invoice is paid with other
invoices for the same supplier site on a single payment.
Suppliers Site – General Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Sites
5. (T) General

Site Uses:

Pay: Supplier site to which payments of invoices are sent. Invoices for a supplier site that is not defined as a pay site cannot be entered.

Purchasing: Default pay site. This pay site defaults as the pay site value in the Invoices window.

Primary Pay: Default pay site. This pay site defaults as the pay site value in the Invoices window.

RFQ Only: An RFQ Only site is a site from which you receive quotations (ECU does not currently use RFQs).

Procurement Card: Supplier site that accepts the credit card brands of your procurement cards (ECU does not currently use Procurement Cards).
**Customer Number:** The number your supplier uses to identify us (ECU). This number appears on the Oracle Purchasing Printed Purchasing Order Report.

**Shipping Network Location:** Physical location of the supplier site.

**Supplier Notification Method:** Primary way you send purchase orders to the supplier. Purchasing uses this value to provide a default value in the Oracle Purchasing Approve Document Window.

- E-mail
- Printed Document
- Fax

**Communication**

- Voice - The area code and telephone number of the supplier.
- Fax - The area code and fax number of the supplier. Purchasing uses this number to fax out purchase orders if the Supplier Notification Method is Fax.
- E-mail - The e-mail address to which notification of approved purchase orders are sent. Purchasing uses this value as a default e-mail address in the Oracle Purchasing Approve Document window if e-mail is selected as the Supplier Notification Method.
Supplier Site – Contacts Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Sites
5. (T) Contacts.

**Note:** Contact information is for your reference only and is not used by the system.

**Prefix:** Enter the appropriate prefix for your contact (Mr., Ms., Dr., etc.).

**Inactive On:** Date on which this contact will no longer appear on the contact list for this supplier site.

**Alternate Contact Name:** You can enter an alternate name for your supplier site contact.
Supplier Site – Payment Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Sites
5. (T) Payment

The information shown on this tab will have defaulted from the Supplier level, but it can be overwritten at the Site level, if information differs from Site to Site:

**Terms:** Payment terms are used to schedule payments for an invoice. The system uses payment terms to automatically calculate due dates, discount dates, and discount amounts for each invoice you enter. The payment terms for a supplier defaults to the supplier site which in turn defaults to the invoices except in the following circumstances:

- A PO Default or QuickMatch invoice is entered in the Invoice Workbench, in which case the terms default from the purchase order.
- An invoice record is imported that has payment terms specified on the record, or the import process can derive terms from purchase order matching.
**Invoice Currency:** The supplier invoice currency is used as a default for new supplier sites you enter. The supplier site invoice currency is used as a default for the Purchasing documents and Payables transactions you enter for a supplier.

**Pay Group:** Pay Group assigned to a supplier. The default for this field is the Payables option defined for Pay Group. The default can be overwritten during supplier site entry or invoice entry. When a payment batch is created, a specific Pay Group can be chosen to pay a category of suppliers or invoices in the same payment batch. Examples of Pay Groups include employees, students, General, Local EFT, Overseas EFT, etc.

**Payment Currency:** The default for Payment Currency in the Suppliers window is the value entered for supplier Invoice Currency. The can be overwritten only if the Invoice Currency has associated fixed-rate currencies (for example, euro). The supplier Payment Currency is used as a default for all new supplier sites entered. The supplier site Payment Currency is the default for the Payment Currency field in the Invoices window. It is also the default currency for invoices you create for this supplier site by using Payment on Receipt, Open Interface Import, and Recurring Invoices.

**Payment Priority:** A number, between 1 (high) and 99 (low), which represents the priority of payment. The system uses the Supplier Site value to automatically assign a Payment Priority to an invoice’s scheduled payment(s) during invoice entry.

**Terms Date Basis:** Date from which Payables calculates a scheduled payment for a supplier. The default is one of the following Payables option you defined for Terms Date Basis.

- System - When invoices are entered, Payables defaults the system date as the terms date.
- Goods Received - When invoices are entered, Payables prompts for the date you the goods that are included on the invoice were received as the terms date.
- Invoice - When invoices are entered, Payables defaults the invoice date as the terms date (DEFAULT).
- Invoice Received - When invoices are entered, Payables prompts for the date the invoice was received as the terms date.
- Always Take Discount - This option is enabled if Payables is always to take an available discount for a supplier, regardless of when the invoice is paid.

**Pay Date Basis:** The Pay Date Basis for a supplier determines the pay date for a supplier’s invoices.

**Exclude Freight From Discount:** If this option is enabled for an invoice, Payables automatically subtracts the freight amount entered on the invoice header from the invoice amount when calculating the invoice amount subject to discount. Payables uses the Discountable Amount on an invoice to calculate the discount amounts when creating a scheduled payment for an invoice.

**Payment Method:** The method most frequently used to pay this supplier’s invoices:

- Cheque - Can be paid with a manual payment, a Quick payment, or in a payment batch.
- Electronic - Electronic payments are paid through the e–Commerce Gateway. Payables creates a file during payment batch creation. E–Commerce Gateway payment files are processed through the e–Commerce Gateway and delivered to your bank to create payments.

**Allow Interest Invoices:** If this option is enabled, Payables calculates interest for the supplier’s overdue invoices and creates corresponding interest invoices when you pay the overdue invoices. Payables calculates interest only for invoices that are overdue 365 days...
or less. If you enable this option, it is automatically enforced for all of a supplier’s sites. Payables automatically enables this option in this window if you enabled this option in the Payables Options window. If this option is not enabled in the Payables Options window, you cannot enable it here.

**Pay Alone:** If this option is enabled for an invoice, Payables creates a separate payment for each invoice. If the option is not enabled for an invoice, the invoice is paid with other invoices for the same supplier site on a single payment.
Supplier Site – Tax Reporting Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Sites
5. (T) Tax Reporting

ABN: Australian Business Number. An ABN is entered for a supplier if it is an Australian Business (i.e. not student, staff or overseas). If an ABN was entered at the Supplier level it will default to the Site level and only needs to be changed if the ABN for the Site is different to that of the Supplier.
This demonstration covers how to execute a Supplier inquiry

(N) ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
Guided Demonstration - Execute a Supplier Inquiry

In this demonstration you will show how to:-
- Query a supplier record
- Establish which one of their sites in the Purchasing Site
- Confirm that the Site is setup to receive emailed purchase orders

Responsibility: (N) ECU Generic Reporting and Inquiries

1. (N) Inquiries > Supplier (AP).

2. Supplier Name = Quantum Consulting Australia.

3. (B) Find.

4. (B) Sites.

5. Press the Down Arrow to cycle through the different Sites until you find the NORTHBRIDGE site and confirm that it has a check in the Site Uses Purchasing checkbox.

6. Confirm that the Supplier Notification Method = Email and that there is an email address recorded in the Communication Email field.

Note: Move around some of the different tabs and highlight the different information that can be found on each.

Points of interest include:

- **Contacts tab**: Name, phone and email address of a contact at the Northbridge site.

- **Payment tab**: Payment Terms, Currency, Payment Method (yes it is American spelling).

- **Invoice Tax tab**: Tax Code.

- **Tax Reporting tab**: ABN (mostly the same as the Supplier header record, but can be different per site, as in the case of franchises).
Practice - Execute a Supplier Inquiry

Overview

In this practice, you will do the following:

- Inquire on a Supplier to determine certain information about that Supplier and their Site(s).

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- User Name = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Supplier (AP).

2. Query on a supplier named Quantum Consulting Australia
   - What is Quantum Consulting Australia’s ABN? _____________________________
   - What type of supplier is Quantum Consulting Australia? __________________

3. Query on the sites of this supplier
   - How many sites does Quantum Consulting Australia have? __________________
   - Name the different sites of Quantum Consulting Australia __________________
   - Which site(s) are Purchasing Sites? _______________________________
   - Which site(s) are Primary Pay Sites? _______________________________
   - Which site wants their purchase orders printed and posted? _______________
   - Which site was made inactive, and on what date? ________________________
Which site has Barbara Jones listed as their contact person? ___________________

What is Barbara’s phone number? ______________________________________

4. Query on another supplier named Golder Gymnasium

What type of Supplier is Golder Gymnasium? ______________________________

Why is there no ABN stored against this supplier? __________________________

5. Query on the sites of this supplier

Where is Golder Gymnasium located? _________________________________

What are the Payment Terms for this site? _______________________________

Who is the contact for this site, and what are their contact details? __________

How is this site going to receive their purchase orders? ____________________

What default tax code will be applied to Golder Gymnasium’s invoices? _______
Solution – Execute a Supplier Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Supplier (AP).
   - Enter Quantum Consulting Australia as your supplier name.
   - Alternatively use Quantum%.

2. (B) Find.
   - What is Quantum Consulting Australia’s ABN? 53 113 145 636
     Note: Supplier Header > ABN field on the right
   - What type of supplier is Quantum Consulting Australia? Contracted Supplier
     Note: Supplier Header > (T) Classification > Type field

3. (B) Sites.
   - How many sites does Quantum Consulting Australia have? 4
     Note: The status bar down the bottom left will tell you “Record: x/y” if you have maximized the Oracle application window. So make sure you do.
   - Name the different sites of Quantum Consulting Australia Albany, Capel, Northbridge, Perth.
     Note: use up and down arrows to show the different sites. Take note of their Site Names as you do.
   - Which site(s) are Purchasing Sites? All
     Note: as you scroll through the different sites, check out (T) General > Site Uses. Look for tick in Purchasing checkbox.
   - Which site(s) are Primary Pay Sites? Perth
     Note: as you scroll through the different sites, check out (T) General > Site Uses. Look for tick in Primary Pay checkbox. There should only be one Primary Pay Site.
   - Which site wants their purchase orders printed and posted? Perth
     Note: as you scroll through the different sites, check out (T) General > Supplier Notification Method. In the case of Perth it is Printed.
   - Which site was made inactive, and on what date? Capel, 18-NOV-2005.
Note: as you scroll through the different sites, look for a date in the Inactive On field in the top half of the screen.

− Which site has Barbara Jones listed as their contact person? **Northbridge**

Note: as you scroll through the different sites, check out (T) Contacts for Contact details.

− What is Barbara’s phone number? **08 6304 2184**

Note: as you scroll through the different sites, check out (T) Contacts for Contact details. You will see the phone and email details for Barbara.

4. Navigate to the Find Suppliers window: (N) > Inquiries > Supplier (AP).

− Enter Golder Gymnasium as your supplier name.

− (B) Find.

− What type of Supplier is Golder Gymnasium? **Overseas**

Note: Supplier Header > (T) Classification > Type field.

− Why is there no ABN stored against this supplier? **Because it’s not an Australian Company.**

6. (B) Sites.

The following relate to Supplier Sites, so assume Supplier Header > (B) Sites.

− Where is Golder Gymnasium located? **Malta**

Note: Site Name field (or Country field, or Address).

− What are the Payment Terms for this site? **7 Days**

Note: (T) Payment > Terms field.

− Who is the contact for this site, and what are their contact details? **Rick Park,** rick.park@malta.net

Note: (T) Contacts > Contact Name and E-mail fields.

− How is this site going to receive their purchase orders? **E-mail**

Note: (T) General > Supplier Notification Method field.

− What default tax code will be applied to Golder Gymnasium’s invoices? **FREE-GST**

Note: (T) Invoice Tax > Invoice Tax Code field.
Agenda

- Perform Supplier Inquiries
- **Perform Invoice Inquiries**
- Perform Payment Inquiries
Invoice Inquiry - Overview

You can find invoices to respond to supplier inquiries, including questions regarding invoice payment status, invoice payment date, reasons an invoice has not been paid, and total balance due for a supplier or supplier site.

You can find invoices in the Invoice Workbench either by using the Find Invoices window or by entering query criteria directly into the Invoices window. In the Find Invoices window, you can enter a greater variety of criteria, including the invoice status and ranges for invoice amounts, and invoice dates. You then choose Find to navigate to the Invoices window, where Payables displays all invoices that match your Find criteria. From the Invoices window, you can review information about an invoice, and you can navigate to other windows to review scheduled payments, distribution holds, related payments, and more.

**Note:** If you need to search on the invoice description you will need to perform that query directly in the Invoices window, because that is not an option on the Find Invoices window.
Invoice Inquiry

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)

2. Open the Find Invoices window. Enter criteria directly into the fields. You can enter complex criteria by entering information in several fields. Some fields are not available until you provide information in other fields. The following are examples of this:
   - You must enter a purchase order number before you can select a purchase order shipment
   - You must enter a supplier before you can enter a site
   - You must enter an invoice type before selecting an invoice status

3. Choose the Find button to navigate to the Invoices window where Payables displays all invoices that match your criteria. Invoices are automatically sorted by invoice type in ascending order.

Attention: The Holds field in the Invoices window shows only invoice holds, not supplier holds. For example, if the supplier site has the Hold All Payments option enabled and there are no invoice holds on an invoice, the Hold field will display zero.
Calculating Balance Owed Window

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Calculate Balance Owed

The Calculate Balance Owed window shows how much you owe a supplier and how many unpaid invoices you have in the system for the supplier.

Use the Find Invoices window and choose the Calculate Balance Owed button to see how much you owe a supplier and how many unpaid invoices you have in the system for the supplier. To calculate the balance owed, Payables subtracts available prepayments from the unpaid invoice amount. Payables does not use unpaid prepayments when it calculates the balance.

If you have foreign currency invoices that do not yet have exchange rates, you can calculate the balance with an exchange rate you enter in the window. The exchange rate you enter will not update the invoices; you are still required to submit AutoRate or enter an exchange rate in the Invoices window.

To calculate a supplier or supplier site balance:-
1. Open the Find Invoices window and enter the supplier name, site name, or other unique supplier or supplier site information. Optionally restrict the balance to invoices of a particular status or hold. Payables calculates the balance based on the combination of criteria you enter. If you do not enter a currency, all invoices are included regardless of currency and the balance is shown in the functional currency.

2. Choose Calculate Balance Owed to have Payables navigate to the Calculate Balance Owed window. Optionally check Take Discount to have Payables reduce the balance by available discounts.

3. Choose Calculate to have Payables display the total due amount and the total number of unpaid invoices that match the criteria you entered. Payables also displays and includes in its calculation any unpaid and available prepayments.

To calculate a supplier or supplier site balance in a foreign currency:-

1. Open the Find Invoices window and enter the supplier name, site name, or other unique supplier or supplier site information. Enter the currency for which you would like to calculate the balance. Optionally restrict the balance to invoices of a particular status or hold. Payables calculates the balance based on the combination of criteria you enter.

2. Choose Calculate Balance Owed to have Payables navigate to the Calculate Balance Owed window. Payables displays the amounts in both the entered currency and your functional currency. Enter a default exchange rate for Payables to use to convert into your functional currency your foreign currency invoices that do not have an exchange rates.

3. Choose Calculate to have Payables display for the invoices that match your criteria the Balance Owed in both the foreign and functional currency, and the total number of unpaid invoices. Payables also displays and includes in its calculation any unpaid and available prepayments.

Calculate Balance Owed Window Reference:-

This window shows a supplier balance for the invoices that match the criteria you enter in the Find Invoices window.

**Default Exchange Rate:** If you have foreign currency invoices that do not yet have exchange rates, you can calculate the balance with an exchange rate you enter in the window. The exchange rate you enter will not update the invoices; you are still required to submit AutoRate or enter an exchange rate in the Invoices window.

**Take Discount:** If you want Payables to reduce the balance by available discounts, then check this check box. Include Outstanding Future Dated Payments: If you want to include in the Balance Owed the amount in the Future Dated Payments field, then enable this check box, then choose the Calculate button.

**Unpaid Amount:** Sum of unpaid, validated and unvalidated invoices. This number includes negative amount invoices but does not include unpaid prepayments. Future Dated Payments: Sum of all outstanding (issued but not matured) future dated payments. If you do not want this amount included in the Balance Owed, then uncheck the Include Outstanding Future Dated Payments check box and then choose the Calculate button.

**Less Available Prepayments:** Available prepayments (the sum of Temporary, paid, unapplied prepayments) include prepayment Item distributions and the associated tax. Payables does not use unvalidated or unpaid prepayments when it calculates the balance because they are not available for application.
**Balance Owed:** Unpaid invoice amount minus available prepayments. If you have enabled the Include Outstanding Future Dated Payments check box, then Payables also subtracts the sum of any outstanding (issued but not matured) future dated payments.

**Number of Invoices:** Number of unpaid invoices, not including unpaid prepayments.

**Number of Prepayments:** Number of available prepayments.
Invoices Window

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find

You can review invoices in either the Invoice Workbench or the Invoice Overview window.
- Invoice Workbench - If you want to be able to enter complex query criteria, review multiple invoices, or review all details about invoices.
- Invoice Overview - If you just want to review high level invoice information for a single invoice, such as invoice status, active holds, scheduled payments, and actual payments.

To review invoices in the Invoice Workbench:-
1. Find the invoice using the Find Invoices window.
2. If you want to review scheduled payments, holds, payments, or prepayment applications choose the appropriate tab in the Invoices window. If you want to view an overview of the invoice, or the distribution lines choose the appropriate button in the Invoices window.
Invoices – General Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (T) General

**Amount Paid:** Amount already paid on the invoice. This amount includes applied prepayments and related tax distributions that do not have the Prepayment on Invoice check box enabled. If the invoice has a payment currency, then it is displayed with the invoice currency above and payment currency below. To see detailed information on the invoice payment(s), select View Payments tab.

- **Status** - Status of an invoice.
- **Validated** - The Invoice Validation program has tested and validated the invoice and it is available for payment and accounting.
- **Available** - Temporary prepayment that has an amount available to be applied to an invoice.
- **Cancelled** - You have cancelled the invoice.
- **Fully Applied** - Temporary prepayment that has been fully applied to one or more invoices.
- Needs Revalidation - Validation has tested the invoice and has applied one or more holds to the invoice. Before you can pay the invoice, you must manually release the holds or resolve the problems causing the holds, then resubmit Validation.

- Never Validated - Validation has never tested the invoice.

- Permanent - Permanent prepayment that has been fully paid.

- Unpaid - Prepayment that is not yet paid.

- Unvalidated Prepayment - Prepayment has not been validated.

- Selected for Payment - Invoice is selected for payment.

Accounted: Payables displays Yes, No, or Partial to indicate if the accounting entry for the invoice has been successfully created. If the status is Partial, then you have created accounting entries for some but not all of the invoice distributions.

Approval: The status of an invoice with respect to the Invoice Approval Workflow program (ECU does not use the Invoice Approval workflow).

- Not Required - Invoice does not require approval. Possible reasons include the following:
  - The Use Invoice Approval Workflow feature is not enabled.
  - The invoice was created by Expense Report Import from an expense report.
  - The invoice is a recurring invoice and the Approval Workflow Required option was not enabled for the template when the invoice was created.
  - Invoice Approval Workflow processed the invoice and determined that no individuals need to review and approve the invoice.
  - The invoice existed before you enabled the Invoice Approval Workflow feature.

- Required - Invoice requires approval and has never been included in the approval process.

- Initiated - Invoice is currently in the approval process.

- Approved - Invoice was approved by all required approvers.

- Manually Approved - An Payables processor manually approved this invoice by using the Force Approval feature.

- Rejected - Invoice was rejected by an approver. Workflow also sets invoices to this status when an approver and the approver's manager both fail to respond to requests for approval within the specified timeout period.

- Needs Reapproval - Invoice will be resubmitted to the approval process.

Pending Approver: Displays the name of the person to whom workflow notification has been sent but has not yet responded.

Description: Payables displays the invoice description.

Holds: If the invoice has an invoice hold, Payables displays the number of invoice holds. Payables does not include the Hold All Payments or scheduled payment holds in this field. To see detailed invoice hold information, choose the Holds tab.

Distribution Total: Sum of the Item, Freight, Tax and Miscellaneous Invoice distributions in the Distributions window. This total does not include Withholding Tax type distributions or some Prepayment type distributions. When you enter an invoice that references a prepayment, the distribution total will include Prepayment distributions and any associated tax distributions that have the Prepayment on Invoice check box enabled. If the Distribution Total does not match the Invoice Amount, Payables will apply a hold to your invoice during Invoice Validation.
Invoices – Holds Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (T) Holds

Use the Invoice Holds tab to view holds to an invoice.

**Hold Name:** If you or the system has placed a hold, Payables displays the name of the hold. If you want to manually apply a hold, enter the hold name here.

**Hold Reason:** The hold reason associated with the hold.

**Held By:** Displays who placed the hold.

**Hold Date:** Displays the date on which the hold was placed.

**Release Name:** If this is a manually releasable hold, enter the release name to release the hold. You can select from all invoice hold names defined with the type Invoice Release Reason. If this is not a manually releasable hold, Payables will notify you if you try to enter a value in this field.

**Release Reason:** The release reason associated with the Release Name.

**Release By:** Displays who released the hold.
**Release Date:** Displays the date on which the hold was released.

**Purchase Order:** If the invoice is purchase order matched, Payables displays the purchase order information for this invoice. You can choose the View PO button to view purchase order details.

**Purchase Order/Shipmen t Quantity/Receipt/Receipt Quantity:** If the hold is related to a purchase order, then Payables will provide information about the purchase order, shipment quantity, receipt, and receipt quantity.

**Receipt:** If the invoice is receipt matched, Payables displays the receipt information for this invoice.
Invoices – View Payments Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (T) View Payments

Payment Method:
- Cheque - A manual cheque, a Quick payment, or a cheque in a payment batch.
- Electronic - An electronic funds transfer file you generate and deliver to your bank to create payments.
- Wire - Wire transfer of funds between your bank and your supplier's bank.
- Clearing - Used for recording invoice payments to internal suppliers within your enterprise.

Document Number:  Payment document number, for example, cheque number.
Payment Date: The GL Date for the payment lines and the date on the payment document. The date must be in an open accounting period.
GL Date: Payment GL Date.
Void: Payables enables this check box if you have voided the payment.
Payment Amount: Amount of the payment.
**Discount Taken**: If you realized a discount when you created the payment, Payables displays the amount of the discount.

**[ ] (Descriptive Flexfield)**: If Shared Services has put a hold on a payment there should be a reference note in here.
Invoices – Scheduled Payments Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (T) Scheduled Payments

All amounts in the Scheduled Payments tab are displayed in the payment currency, except for the Gross Amount, which is displayed in the invoice currency.

**Hold:** This checkbox is checked if you a payment hold has been applied to the scheduled payment line. If a scheduled payment has a payment hold, Payables will not create a payment for that scheduled payment until the check box is unchecked.

**Due Date:** Payables calculates the date the invoice is due based on the invoice Terms Date and invoice Payment Terms. For example, if the terms date is January 1, 2006, and the invoice payment terms are Net 30, the Due Date is January 30, 2006.

**Gross Amount:** Gross amount due for the scheduled payment, displayed in the invoice currency. Payables subtracts the discount amount, automatic withholding amount, and prepayment amount from the gross amount to calculate the payment amount.

**Payment Currency:** Currency in which the payment will be made.
**Payment Priority:** A number, between 1 (high) and 99 (low), that represents the priority of payment. The value for this field defaults from the invoice batch one was specified in the Invoice Batches window. Otherwise it defaults from the supplier site. A payment priority range can be entered as a criteria for selecting invoices for a payment batch.

**Payment Method:** Payables defaults the payment method from the invoice (Cheque, Electronic, Wire, or Clearing).

**Bank Account Name:** Name of the account from which a scheduled payment will be made.

**Bank Account Number:** Number of the account from which a scheduled payment will be made.

**Discount/ Second Discount/Third Discount Date/Amount:** Payables displays the discount amount you are eligible to subtract from the gross amount if you pay the invoice before the corresponding discount date. For example, you enter a $100 invoice with a payment terms date of January 1, 2006, and your payment terms allow you to take either a 10% discount if you pay within 10 days, or a 5% discount if you pay within 20 days. When you select Discount, the date is January 10, 2006, and the amount is $10.00. You select Second Discount, and the date is January 10, 2006, and the amount is $5.00. If you make the payment on or before eligible discount dates, you choose between paying the gross amount of the invoice or taking the most favourable discount option.

**Amount Remaining:** Payables displays the unpaid amount of a selected scheduled payment line.

**Discount Amount Remaining:** Payables displays the first discount amount available on the unpaid amount of a scheduled payment line. Payables displays the discount amount you would realise if you paid the scheduled payment today.

**Amount Paid:** Invoice amount minus the gross amounts of the remaining payments. The Amount Paid does not reflect discounts you realise on payments. It shows the actual amount disbursed. For example, for a $100 invoice, if you paid $90 and realised a $10 discount, then Payables displays $90 in the Amount Paid field.

**Invoice Amount:** Amount of the invoice, displayed in the payment currency. If this is a prepayment, Payables displays the amount of the prepayment that remains unapplied.

**Gross Amount Total:** Sum of the scheduled payment Gross Amounts. This must equal the Invoice Amount.
Invoices – View Prepayment Applications Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (T) View Prepayment Applications

The View Prepayment Applications tab displays the prepayments applied to the invoice.

**Amount Applied:** Amount of prepayment applied to the invoice.

**Invoice Number:** Invoice toward which the prepayment has been made.

**Prepayment Dist:** Distribution number for the prepayment distribution item.

**Tax Code:** Tax code for the prepayment, if different from the code listed at the Invoice header level.

**Account:** Account from which the prepayment was made.

**PO Num/Receipt Num:** Payables populates these fields for prepayments related to a purchase order.
Invoices – Overview Window

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Overview

In the Invoice Overview window, you can review the status of an invoice and some high-level information. This window is particularly helpful for reviewing information quickly when a supplier calls you to inquire about the status of an invoice. This window also serves as a bridge between the Payment and Invoice Workbenches.

This window displays summary information for the invoice:
- Supplier Information
- Invoice Information
- Invoice Status
- Scheduled Payments
- Actual Payments
- Active Holds
- Purchase Order Information
**Warning:** The Active Hold region does not include scheduled payment holds or supplier site holds. For example, if the supplier site has the Hold All Payments option enabled you will not see a hold in the Active Hold region of the Invoice Overview.

This is a display–only window.

For more detailed information regarding the invoice or related attributes, choose the Invoices, Supplier, View PO, View Receipt, or Payment Overview button.
Invoices – View Accounting

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B)  Find
4. (M)  Tools > View Accounting

You can view the detail accounting lines for the transaction in the form of a balanced accounting entry (i.e. debit equals credit). You can also choose to view the detail accounting as T-Accounts from this window.

Note: This is a good way to find out what the $AUD equivalent of a foreign currency invoice is.

To view the T-Accounts of the same invoice lines:-
1. (B)  T-Accounts
Invoices – Distributions Window

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Distributions

From the Distributions window, you can use the Find Invoice Distributions window to search for distributions for one invoice that match criteria you select. For example, if you have an invoice with a large number of distributions, you can view only distributions that meet criteria you specify. You can search by accounted status, GL date range, amount range, and account range.

To find invoice distributions in the Invoice Workbench:
1. In the Invoices window, select an invoice and choose Distributions.
2. Open the Find Invoice Distributions window from the Distributions window, either by choosing the Find icon from the Toolbar or by selecting Find from the View menu.
3. Enter criteria directly into the fields. You can enter complex criteria by entering information in several fields.
4. Choose Find to navigate to the Distributions window where Payables displays all invoice distributions of the invoice you selected that match your criteria.
This demonstration covers how to execute an Invoice inquiry

(N) ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
Guided Demonstration - Execute an Invoice Inquiry

In this demonstration you will show how to search for an invoice

**Responsibility:** ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP).

- Note: This demonstration inquires on an invoice to determine if an invoice has been paid, and if not, why not (or when it will be paid).

1. Query a supplier invoice to establish when payment of that invoice can be expected.
2. Supplier Name = Quantum Consulting Australia.
3. (B) Find.
4. (T) Scheduled Payments.
5. Advise the date shown in the Due Date field.
   - Note: If the due date has passed and the invoice is still unpaid, then look around the other tabs to find out why (i.e. it could be on hold, or was only entered recently – even though it’s an old invoice).
Practice - Execute an Invoice Inquiry

Overview

In this practice, you will do the following:

- Inquire on a Supplier Invoice to determine certain information about that invoice.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- User Name = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Invoice (AP).

2. Query on invoice 12345 for a supplier named Quantum Consulting Australia

   - When will this invoice be paid? ________________________________
   - How much is this invoice for? ________________________________
   - Which project(s) are being debited to pay for the items on this invoice? __________
     _____________________________________________________________
   - How will this invoice be paid? ________________________________
   - What Invoice Batch does this invoice belong to? _________________
   - Who entered this invoice into the system? ________________________

3. Query on invoice 11125 for a Supplier named Golder Gymnasium.

   - What currency is the invoice in? ________________________________
   - What is the $AUD equivalent? ________________________________
   - What are the Exchange Rate, Exchange Date, and Rate Type? ________________
     _____________________________________________________________
- There is a hold on this invoice – why? ________________________________
- What purchase order does this invoice relate to? _______________________
Solution – Execute an Invoice Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Invoice (AP).

2. Enter Quantum Consulting Australia as your supplier name.
   - Enter 12345 as the invoice number.
   - (B) Find.
   - When will this invoice be paid? *Half 31-Jan-2006, and half 30-JUN-2006*
     
     Note: (T) Payment Schedule > Due Date field.
   - How much is this invoice for? *$5,000.00*
     
     Note: Top half of screen shows invoice header information. 8th field across is Invoice Amount field.
   - Which project(s) are being debited to pay for the items on this invoice? *68000 – MSC Financial Services*
     
     Note: (B) Distributions >Account field > first segment.
   - How will this invoice be paid? *Check (American spelling of cheque)*
     
     Note: scroll across top half of screen to Payment Method field (nearly all the way to the right) or (T) Payment Method > Method field.
   - What Invoice Batch does this invoice belong to? *AK326*
     
     Note: (B) Overview > Batch Name field (4th field down on left).
   - Who entered this invoice into the system? *AKING*
     
     Note: (M) Help > Record History.

3. Navigate to the Find Invoices window: (N) > Inquiries > Invoice (AP).
   - Enter Golder Gymnasium as your supplier name.
   - Enter 11125 as the invoice number.
   - (B) Find.
   - What currency is the invoice in? *EUR*
Note: Look for the Invoice Curr field in the top half of the screen. It should be visible without having to scroll.

− What is the $AUD equivalent?  

5838.54

Note: use (M) Tools -> View Accounting (if accounted) to see the AUD equivalent of a foreign currency invoice or check the Functional Amt column (if not accounted) just after the Descriptive Flexfield. This invoice is not accounted because it is on hold so you have to scroll across the top half of the screen to the Functional Amt column. You should have to scroll a little bit to the right to see it.

− What are the Exchange Rate, Exchange Date, and Rate Type?  

Rate = 1.60046, Date = 18-NOV-2005, Rate Type = Corporate.

Note: In the top half of the screen scroll almost to the end and look for Exchange Rate, Exchange Date and Rate Type fields.

− There is a hold on this invoice – why?  

QtyRec – Quantity billed exceeds quantity received

Note: (T) Holds > Hold Name and Hold Reason fields.

− What purchase order does this invoice relate to?  

238

Note: use (B) Overview > PO Number field (6th down on the left) or (B) Distributions > PO Number column (scroll just a little to the right).
Agenda

- Perform Supplier Inquiries
- Perform Invoice Inquiries
- Perform Payment Inquiries
Payment Inquiry

1. ECU Generic Reporting and Inquiries > Inquiries > Payment (AP)
2. Open the Find Payments window from the Payment Summary, either by choosing the Find icon from the Toolbar or by selecting Find from the View menu. Enter criteria directly into the fields. You can enter complex criteria by entering information in several fields.
3. Choose Find to navigate to the Payments window where Payables displays all payments that match your criteria.

For more detailed information regarding the payment or related attributes, choose Payment Overview.
Payments Window

1. ECU Generic Reporting and Inquiries > Inquiries > Payment (AP)
2. <enter search criteria>
3. (B) Find

You can review payments in either the Payments Workbench or the Payment Overview window. If you want to be able to enter complex query criteria and review multiple payments, use the Payments window. You can review all details about the payments in the Payments Workbench: the invoices each payment paid, clearing information, bank information, and more. If you just want to review high level payment information for a single payment, for example, to quickly review the invoices paid by a payment or to see if a particular payment has cleared your bank, use the Payment Overview window.

To review invoices paid on a payment:-
1. Find the payment using the Find Payments window.
2. From the Payments window select the payment you are interested in. Payables displays all invoices paid by a payment in the Invoices region.
Payment Overview

1. ECU Generic Reporting and Inquiries > Inquiries > Payment (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Payment Overview

In the Payment Overview window, you can query a payment and review its status and its related high-level information. This window is particularly helpful for reviewing information quickly when a supplier calls you to inquire about the status of a payment. This window also serves as a bridge between the Payment and Invoice Workbenches. This window displays summary information for the payment:

- Payment Status
- Payment Information
- Supplier Information
- Invoice Information
- Bank Information

This is a display-only window.

If your query retrieves more than one payment, Payables orders and displays queried payments in numerical order based on the payment number.
You can also use the Find Payments window to query payments based on ranges of payment numbers and payment dates. When you choose Inquiries > Payment from the Navigator, Payables navigates to the Find Payments window. You can also open the Find Payments window from the Payment Overview window either by choosing the Find icon from the Toolbar or by selecting Find from the View menu.

For more detailed information regarding the payment or related attributes, choose Payments, Supplier, Bank, or Invoice Overview.
Invoice Overview

1. ECU Generic Reporting and Inquiries > Inquiries > Payment (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Invoice Overview

In the Invoice Overview window, you can review the status of an invoice and some high-level information. This window is particularly helpful for reviewing information quickly when a supplier calls you to inquire about the status of an invoice. This window also serves as a bridge between the Payment and Invoice Workbenches.

This window displays summary information for the invoice:
- Supplier Information
- Invoice Information
- Invoice Status
- Scheduled Payments
- Actual Payments
- Active Holds
- Purchase Order Information
**Warning:** The Active Hold region does not include scheduled payment holds or supplier site holds. For example, if the supplier site has the Hold All Payments option enabled you will not see a hold in the Active Hold region of the Invoice Overview.

This is a display–only window.

For more detailed information regarding the invoice or related attributes, choose the Invoices, Supplier, View PO, View Receipt, or Payment Overview button.
This demonstration covers how to execute a Payment inquiry

(N) ECU Generic Reporting and Inquiries > Inquiries > Payment (AP)
Guided Demonstration - Execute a Payment Inquiry

In this demonstration you will show how to search for payments.

**Responsibility:** ECU Generic Reporting and Inquiries

2. (N) Inquiries > Payment (AP)

3. Payment Number = 7

5. (B) Find
Practice - Execute a Payment Inquiry

Overview

In this practice, you will do the following:

- Inquire on a Cheque Number to determine certain information about the payment.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- User Name = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Payment (AP).

2. Query on cheque number 7 for a supplier named Quantum Consulting Australia
   - How much is this payment for? ________________________________
   - What date of the payment? ________________________________
   - What payment method was used to create this payment? _________________
   - How many invoices does this payment cover? _____________________
   - What address will the payment be sent to? _______________________

Copyright © Oracle, 2004. All rights reserved.
Solution – Execute a Payment Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Payment (AP).
   
   − Enter 7 as the payment number.
   
   − (B) Find.
   
   − How much is this payment for? $330.00
     
     Note: Top half of screen relates to the payment (bottom half to the invoices being paid). Look for the Payment Amount screen – it should be visible without scrolling.
   
   − What date of the payment? 18-NOV-2005
     
     Note: Scroll across the top half of the screen to the right a little to see the Payment Date field.
   
   − What payment method was used to create this payment? Check (American spelling of Cheque)
     
     Note: Scroll across the top half of the screen to the right a little to see the Payment Method field.
   
   − How many invoices does this payment cover? BI
     
     Note: Count the number of lines (records) in the bottom half of the screen.
   
   − What address will the payment be sent to? PO Box Y3499 Perth WA 6000
     
     Note: Back up to the top half of the screen and scroll across to the right some more (a bit under half way on the scroll bar) to the Address field.
Summary

You should now be able to do the following:

- Perform Supplier Inquiries
- Perform Invoice Inquiries
- Perform Payment Inquiries
Oracle 11i – Purchasing Inquiries
Objectives

After completing this lesson you should be able to do the following:

- Perform Requisition Inquiries
- Perform Purchase Order Inquiries
Agenda

- Perform Requisition Inquiries
- Perform Purchase Order Inquiries
To perform a Requisition Inquiry:

1. ECU Generic Reporting and Inquiries > Inquiries > Requisition
2. Enter as many as desired, of the search criteria described in the following steps.
3. Enter the requisition number.
4. Enter the Preparer.
5. Enter the Requester.
6. Enter the Buyer.
7. Select Yes or No to restrict the search to Modified requisitions.
8. Enter the Line Type.
9. Use the tabbed regions to further restrict the search:
   - In the Line region, you can enter the following search criteria: Item number, Revision number, Category, Item Description, and Supplier Item number.
   - In the Status region, you can limit the search by Approval status (Approved, Incomplete, In Process, Pre–Approved, Rejected, or Returned), Control status (Open, Cancelled, or Finally Closed), or Reserved status (Yes or No).
   - In the Date Ranges region, you can enter date ranges for the following dates: Creation, Need By, and Closed.
- In the Sourcing region, you can limit the search by Source (Supplier or Inventory). For Supplier sourced requisitions, you can further limit the search by Supplier, Site, VMI Only and Currency.

- In the Deliver To region, you can limit the search by Deliver To Location (Expense, Inventory, or Shop Floor), Organisation, Subinventory and Location.

- In the Related Documents region, you can limit the search by Document Type, Document number and Line Number, Sales Order number and Purchase Order number.

- In the Accounting region, you can limit the search by Period, GL Date, Charge Account, Budget Account, and whether there are Active Encumbrances (Yes or No).

- In the Projects region, you can limit the search by Project or Task number.

10. Select the Results group (Headers, Lines, or Distributions) to determine which summary window to open. Depending on the search criteria you have specified, all summary windows may not be available. For example, if you specify criteria in the Accounting region, only the Distributions summary window is available.

11. (B) Find

**To clear existing search criteria:**
Select the Clear button to clear any existing search criteria.
Using the Requisition Headers Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Requisition
2. <enter search criteria>
3. (B) Find

Use the Requisition Headers Summary folder window to:
- View requisition header information.
- Drill down to view requisition line and distribution information.
- View information in the Action History window.

To navigate to the Requisition Headers Summary window:-

1. In the Find Requisitions window, select Headers in the Results region and select the Find button to open the Requisition Headers Summary folder window.

The following information is displayed: Requisition Number, Description, Approval Status, Creation Date, Preparer, Currency, Total Amount, Cancelled Status, Closed Status, and Type.
To drill down to view requisition line information:-
1. Select the Lines button to drill down to the Requisition Lines Summary folder window. You can also select View Lines on the Tools menu to open this window.

To view requisition distributions information:-
1. Select View Distributions on the Tools menu to open the Requisition Distributions Summary folder window
Requisition Lines Summary Window

Using the Requisition Lines Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Requisition
2. Enter search criteria
3. (B) Find
4. (B) Lines

Use the Requisition Lines Summary folder window to:

- View requisition line information.
- Drill down to view requisition distribution information.
- View information in the Action History window.
- View purchase order information, if the requisition has been placed on a purchase.

To navigate to the Requisition Lines Summary window:

1. In the Find Requisitions window, select Lines in the Results region and select the Find button to open the Requisition Lines Summary folder window. You can also navigate to this window from the Requisition Headers Summary window by selecting the Lines button or View Lines on the Tools menu.

The following information is displayed: Requisition Number, Purchase Order Number, Line, Item, Description, Category, Quantity Ordered, UOM (Unit of Measure), Price, Line,
Amount, Need-By Date, Qty Delivered, Deliver-To Location, Requester, Item, Cancelled Status, Cancelled Reason, Closed Date, Closed Reason, Tax Code, and Contract Number.

To drill down to view requisition distribution information:
1. Select the Distributions button to drill down to the Requisition Distributions Summary folder window. You can also select View Distributions on the Tools menu to open this window.
Using the Requisition Distributions Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Requisition
2. <enter search criteria>
3. (B) Find
4. (B) Lines
5. (B) Distributions

Use the Requisition Distributions Summary folder window to:
- View requisition distribution information.

To navigate to the Requisition Distributions Summary window:
1. In the Find Requisitions window, select Distributions in the Results region and select the Find button to open the Requisition Distributions Summary folder window. You can also navigate to this window by selecting View Distributions on the Tools menu in the Requisition Headers Summary and Requisition Lines Summary windows.

The following information is displayed: requisition Number, Line number, Distribution number, Item, item Description, UOM, Price, Quantity, Amount, Charge Account, Contract Line number, and Contract Deliverable number.
This demonstration covers how to execute a Requisitions inquiry

(N) ECU Generic Reporting and Inquiries > Inquiries > Requisition
Guided Demonstration - Execute a Requisition Inquiry

In this demonstration you will show how to query a requisition.

Responsibility: ECU Generic Reporting and Inquiries

Who prepared the latest requisition to Quantum Consulting Australia?

1. (N) Inquiries > Requisition
2. (T) Sourcing
3. Source = Supplier
4. Supplier Name = Quantum Consulting Australia
5. (B) Find
   - Note: The first record should be the one created most recently.
6. Scroll across to the Preparer field – the contents of that field is the person who prepared the requisition.
   - Note: In most instances the person who prepares the requisition is the requester, but this is not always the case.
   - Note: Highlight all the things you can see in the Requisition Line Summary window (and to a lesser extent the Tools menu).
Practice - Execute a Requisition Inquiry

Overview

In this practice, you will do the following:

- Inquire on requisitions to determine certain information about requisitions and subsequent purchase order created.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- User Name = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Requisition.

2. Query on requisitions raised against supplier Quantum Consulting Australia
   - How many requisitions have been raised to this supplier? _____________________
   - How many of them have been converted to purchase orders? ______________
   - What charge account was used on the most recent requisition? _______________
   - Who created this requisition? ___________________________________________
   - Who requested it? ____________________________________________________
   - Who approved it? ____________________________________________________
   - Where will the items be delivered? ______________________________________
   - What category was used on the first requisition created? __________________

3. Query on requisitions created by ECUTRN, Trainer 01
   - What charge account was used on the most recent requisition? ______________
   - Which supplier is it for? _______________________________________________
- What status is it in? ___________________________________________________
- When was requisition 6 created? _______________________________________

4. Challenge!
- Which requisitions were raised in EUROs? ________________________________
Solution – Execute a Requisition Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. Navigate to the Find Requisitions window:
   − (N) Inquiries > Requisitions.
   − (T) Sourcing.
   − Source = Supplier.

2. Query on requisitions raised against supplier Quantum Consulting Australia
   − Enter Quantum Consulting Australia as the supplier name.
   − (B) Find.
   − How many requisitions have been raised to this supplier? 2
     Note: Make sure your Oracle applications window is maximized to full size so that you can see the status bar down the bottom left. There you will see that two records meet the criteria of your search.
   − How many of them have been converted to purchase orders? 2
     Note: Scroll right across to the right to see the Order Number field. If this field has no entry then a purchase order has not yet been created from this requisition.
   − What charge account was used on requisition 15? 68000.2430.4001.SA.06.01
     Note: (M) Tools > View Distributions, or (B) Distributions. See the Charge Account field (shouldn’t have to scroll for this).
   − Who created this requisition? King, Allison
     Note: Go back to the Requisition Lines screen and scroll across about half way on the scroll bar to the Preparer field.
   − Who requested it? King, Allison
     Note: Go back to the Requisition Lines screen and scroll across about half way on the scroll bar to the Requester field.
   − Who approved it? ECUTRN, Top
     Note: (M) Tools > Action History.
   − Where will the items be delivered? JO.01.2101
     Note: In the Requisition Lines screen scroll across nearly to the end to see the Location field. The naming convention is Campus.Building.Room.
– What category was used on requisition 14? **Professional Fees. Consultants**

Note: In the Requisition Lines screen look for the Category field (it’s pretty close the front, so you shouldn’t need to scroll for it).

3. Query on requisitions created by ECUTRN, Trainer 01

– Navigate to the Find Requisitions window: (N) Inquiries > Requisitions.
– Enter ECUTRN, Trainer 01 as the preparer name.
– (B) Find.
– What charge account was used on requisition 18? **02030.0384.5201-SA.06.01**

Note: (M) Tools > View Distributions, or (B) Lines > (B) Distributions. Look in Charge Account field.
– Which supplier is it for? **Golder Gymnasium**

Note: Back out to the Requisition Lines screen and look in the Supplier field.
– What status is it in? **Approved**

Note: Back out to the Requisition Header screen and look in the Approval Status field.
– When was requisition 6 created? **21-NOV-2005 15:46:46**

Note: Stay at Requisition Header level and look in the Creation Date field.

4. Challenge!

– Which requisitions were raised in EUROs? **3, 9, 11, 17 and 18 – all to Golder Gymnasium**

Note: This is a tricky one. You need to go back to the Find Requisitions window > (B) Clear (to clear existing search) > (T) Sourcing > Source = Supplier > Currency = EUR > (B) Find. Scroll across to the Currency field for confirmation.
Agenda

- Perform Requisition Inquiries
- Perform Purchase Order Inquiries
To perform a Purchase Order Inquiry:

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. Enter desired search criteria as described in the following steps.
3. Enter the purchase order number. If you enter a purchase order number, you can also enter a Release, Line, and / or Shipment number for the purchase order.
4. Enter the Currency.
5. Enter the Supplier. If you enter a supplier, you can also enter a supplier Site.
6. Enter the Bill To location.
7. Enter the Line Type.
8. Enter the Ship To location.
9. Enter the Buyer.
10. Use the tabbed regions to further restrict the search:
    - In the Line region, you can enter the following search criteria: Item / Revision number, Category, Item Description, and Supplier Item Number.
    - In the Date Ranges region, you can enter date ranges for the following dates: Order, Approved, Promised, Need By, VMI Consigned and Closed.
    - In the Status region, you can limit the search by:
      - Order Approval status (Approved, In Process, Incomplete, Pre-Approved, Rejected, or Requires Reapproval)
- Control status (Open, Closed, Finally Closed, Closed for Invoicing, Closed for Receiving or Cancelled).
- Hold status (Yes or No)
- Frozen status (Yes or No)
- Firmed status (Yes or No)
- In the Related Documents region, you can limit the search by Contract number, Receipt number, Invoice number, Paper Requisition, Supplier Quote, Source Document, Type, Number, Line and Requisition number.
- In the Deliver To region, you can limit the search by destination Type (Expense, Inventory, Shop Floor), Requester, Organisation Subinventory and Location.
- In the Accounting region, you can limit the search by Period, GL Date, Charge Account, Budget Account, and whether there are Active Encumbrances (Yes or No).
- In the Projects region, you can limit the search by Project or Task number.

11. Select the Results summary window (Headers, Lines, Shipments, or Distributions). Depending on the search criteria you have specified, all summary windows may not be available. For example, if you specify criteria in the Accounting region, only the Purchase Order Distributions summary window is available.

12. Select the Find button to initiate the search and open the appropriate summary window.
Using the Purchase Orders Headers Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. <enter search criteria>
3. (B) Find

Use the Purchase Order Headers results folder window to:
- View purchase order header information.
- Drill down to view purchase order line, shipment, and distribution information.
- Access other windows from the Tools and Inquire menus.

To navigate to the Purchase Order Headers results window:-
1. In the Find Purchase Orders window, select Headers in the Results region and select the Find button to open the Purchase Order Headers folder window.

To drill down to view purchase order line information:-
1. Select the Lines button to drill down to the Purchase Order Lines results folder window. You can also select View Lines on the Inquire menu to open this window.
To drill down to view purchase order shipment information:-
1. Select View Shipments on the Inquire menu to open the Purchase Order Shipments results folder window.

To drill down to view purchase order distributions information:-
1. Select View Distributions on the Inquire menu to open the Purchase Order Distributions results folder window.

To view action history:-
1. Select View Action History on the Inquire menu to open the Action History window.

To view invoices:-
1. Select Invoices on the Inquire menu to view invoice information.

To view receipts:-
1. Select View Receipts on the Inquire menu to open the Find Receiving Transactions window.

To communicate the purchase order to the supplier:-
1. Select an approved purchase order and then select “Communicate” from the Tools menu. In the Communicate window select the method that you would like to use to communicate this purchase order to the supplier. Enter the Fax number or Email address as needed. Click OK to send the purchase order.
2. Purchase orders are usually communicated to the supplier at the time they are approved, but you can use this method to send another copy of the order if your supplier has misplaced it, or to send yourself a copy for your own records.
Using the Purchase Order Lines Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. <enter search criteria>
3. (B) Find
4. (B) Lines

Use the Purchase Order Lines results folder window to:

- View purchase order line information.
- Drill down to view purchase order shipment and distribution information.
- Access other windows from the Tools and Inquire menus.

To navigate to the Purchase Order Lines results window:

1. In the Find Purchase Orders window, select Lines in the Results region and select the Find button to open the Purchase Order Lines folder window. You can also navigate to this window by selecting View Lines on the Inquire menu in the Purchase Order Headers results folder window.
To drill down to view purchase order shipment information:-
1. Select the Shipments button to drill down to the Purchase Order Shipments results folder window. You can also select View Shipments on the Inquire menu to open this window.

To drill down to view purchase order distributions information:-
1. Select View Distributions on the Inquire menu to open the Purchase Order Distributions results folder window.

To view invoices:-
1. Select View Invoices on the Inquire menu to view invoice Information.

To view receipts:-
1. Select View Receipts on the Inquire menu to open the Find Receiving Transactions window.

To communicate the purchase order to the supplier:-
1. Select an approved purchase order and then select “Communicate” from the Tools menu. In the Communicate window select the method that you would like to use to communicate this purchase order to the supplier. Enter the Fax number or Email address as needed. Click OK to send the purchase order.
2. Purchase orders are usually communicated to the supplier at the time they are approved, but you can use this method to send another copy of the order if your supplier has misplaced it, or to send yourself a copy for your own records.
Using the Purchase Order Shipments Summary Screen

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. <enter search criteria>
3. (B) Find
4. (B) Lines
5. (B) Shipments

Use the Purchase Order Shipments results folder window to:
- View purchase order shipment information.
- Drill down to view purchase order distribution information.
- Access other windows from the Tools and Inquire menus.

**Note:** this window does not display price breaks.

To navigate to the Purchase Order Shipments results window:-

1. In the Find Purchase Orders window, select Shipments in the Results region and select the Find button to open the Purchase Order Shipments folder window. You can also navigate to this window by selecting View Shipments on the Inquire menu in the Purchase Order Headers and Purchase Order Lines results folder windows.
To drill down to view purchase order distribution information:-
1. Select the Distributions button to drill down to the Purchase Order Distributions results folder window. You can also select View Distributions on the Inquire menu to open this window.

To view invoices:-
1. Select View Invoices on the Inquire menu to view invoice information:

To view receipts:-
1. Select View Receipts on the Inquire menu to open the Find Receiving Transactions window.

To view the requisitions for this shipment:-
1. Select View Requisitions on the Inquire menu to open the Requisition Lines Summary window.

To communicate the purchase order to the supplier:-
1. Select an approved purchase order and then select “Communicate” from the Tools menu. In the Communicate window select the method that you would like to use to communicate this purchase order to the supplier. Enter the Fax number or Email address as needed. Click OK to send the purchase order.
2. Purchase orders are usually communicated to the supplier at the time they are approved, but you can use this method to send another copy of the order if your supplier has misplaced it, or to send yourself a copy for your own records.
Using the Purchase Order Distributions Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. <enter search criteria>
3. (B) Find
4. (B) Lines
5. (B) Shipments
6. (B) Distributions

Use the Purchase Order Distributions results folder window to:
- View purchase order distribution information.
- Access the Purchase Orders and Releases windows for entry and update of documents.
- Access other windows from the Tools and Inquire menus.

To navigate to the Purchase Order Distributions results window:-
1. In the Find Purchase Orders window, select Distributions in the Results region and select the Find button to open the Purchase Order Distributions folder window. You can also navigate to this window by selecting View Distributions on the Inquire menu in the Purchase Order Headers, Purchase Order Lines, and Purchase Order Shipments results folder windows.
To view invoices:-
1. Select View Invoices on the Inquire menu to view invoice Information.

To view receipts:-
1. Select View Receipts on the Inquire menu to open the Find Receiving Transactions window

To communicate the purchase order to the supplier:-
1. Select an approved purchase order and then select “Communicate” from the Tools menu. In the Communicate window select the method that you would like to use to communicate this purchase order to the supplier. Enter the Fax number or Email address as needed. Click OK to send the purchase order.
2. Purchase orders are usually communicated to the supplier at the time they are approved, but you can use this method to send another copy of the order if your supplier has misplaced it, or to send yourself a copy for your own records.
This demonstration covers how to execute a Purchase Order inquiry

(N) ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
Guided Demonstration - Execute a Purchase Order Inquiry

In this demonstration you will show how to:-
  − Search for a Purchase Order
  − Send a copy of a Purchase Order to a Supplier

**Responsibility: ECU Generic Reporting and Inquiries**

1. (N) > Inquiries > Purchase Order
2. Type = Standard Purchase Order.
3. Supplier Name = Golder Gymnasium.
4. (T) Deliver To.
5. Requester Name = ECUTRN, Trainer 01.
6. (B) Find.
7. Scroll through the list until you find the correct order.
   − Note: If you can’t tell which one is the correct purchase order just by looking at the
     header level, you can drill down to the purchase order lines for more information.
8. (M) Tools > Communicate.
9. Confirm that the email address / fax number is correct (or add them in if they are missing).
   − Note: Changing the email address or fax number at this point will only affect this
     particular order – it will not affect any orders already created or any that will be
     created in the future. If you need the change to be permanent you will need to
     contact Shared Services and request that they update the supplier record.
10. (B) OK.
    − Note: Highlight all the things you can view from the Inquire menu (and to a lesser
        extent the Tools menu). In particular View Invoices, View Receipts, View
        Document, View Action History.
Practice - Execute a Purchase Order Inquiry

Overview

In this practice, you will do the following:

• Inquire on a Supplier Invoice to determine certain information about that invoice.

Assumptions

• You must have access to the Training database on which to complete this practice.
• Where XX is referenced, you will use the number shown on the training terminal you are using.

Log on to the System

− User Name = ecutrnXX
− Password = ecutrnXX
− Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Purchase Order.

2. Query on purchase orders raised against supplier Golder Gymnasium

   − Why did you have to search only on Standard Purchase Orders? ________________

   − How many purchase orders have been raised to this supplier? _______________

   − Does the number of purchase orders raised equal the number of requisitions raised? _______________

   − Why do you think that is? ____________________________________________

   − Find a purchase order that has a matched amount and view the invoice. What is the invoice number? _______________

   − Who input this invoice into the system? ________________________________

   − The invoice is on hold - why? _________________________________________

   − What are the Quantity Ordered, Quantity Received, and Quantity Billed amounts for PO 238? ________________________________

   − Who raised the requisition for PO 247? ________________________________
3. Query on purchase orders requested by Train, Ms. 01

- What is the first purchase order number raised by ECUTRN, Trainer 01? ________
- How many lines are on PO 240? __________________________
- When was the item ordered on PO 240 line 4 received? __________________________
- Is there an invoice matched to this purchase order? __________________________
- If so, what is the invoice number? __________________________
- How much is the invoice for? __________________________
- How much of the invoice has been matched to the purchase order? ________
- Why is the invoice total different to the amount matched to the purchase order?
  __________________________
- Has the invoice been paid yet? __________________________
- Is the invoice on hold? __________________________
Solution – Execute a Purchase Order Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. **(N)** Inquiries > Purchase Order.

2. Query on purchase orders raised against supplier Golder Gymnasium.
   
   - Enter Standard Purchase Order as the type.
   
   - Enter Golder Gymnasium as your supplier name.
   
   - **(B)** Find.
   
   - **Why did you have to search only on Standard Purchase Orders?** *So you don’t see Contract Purchase Orders.*
     
     Note: If the students have trouble answering the question above, get them to try running the query without the type, and then again with it to see the difference.
   
   - **How many purchase orders have been raised to this supplier?** 5
     
     Note: Make sure your Oracle applications window is expanded to full size so that you can see the status bar at the bottom left. It will show you that there are 5 purchase orders that match the search criteria entered on the Find screen.
   
   - **Does the number of purchase orders raised equal the number of requisitions raised?**
     
     *No, there are 5 PO’s but 6 requisitions.*
     
     Note: To answer this question you will need to note the number of PO’s raised, and then go and run a Requisition Inquiry and note the number of unique requisitions.
   
   - **Why do you think that is?** *One of the requisitions hasn’t been converted to a PO (requisition 10 was cancelled)*
   
   - Find a purchase order that has a matched amount and view the invoice. What is the invoice number? *Invoice Number 11125 has been matched to PO 238*
     
     Note: **(M)** Inquire > View Invoices > Invoices field.
   
   - **Who input this invoice into the system?** *AKING*
     
     Note: **(M)** Help > Record History.
   
   - **The invoice is on hold - why?** *QtyRec – we already answered this question in the Invoice Inquiry section.*
     
     Note: perform an Invoice Inquiry on the supplier > **(T)** Holds.
What are the Quantity Ordered, Quantity Received, and Quantity Billed amounts for PO 238?

\[ \text{Qty Ordered} = 3648.04, \quad \text{Qty Rec'd} = 0, \quad \text{Qty Billed} = 3648.04 \]

Note: (M) Inquire > View Shipments, or (B) Lines > (B) Shipments. Look in Quantity, Qty Rec’d and Qty Billed fields.

Who raised the requisition for PO 247?

\[ \text{King, Allison} \]

Note: (M) Inquire > View Distributions or drill right down to the Purchase Order Distributions window ( (B) Lines > (B) Shipments > (B) Distributions) and scroll across to the Deliver-To Person field.

3. Navigate to the Find Purchase Orders window:

- (T) Deliver To.
- Requester = ECUTRN, Trainer 01
- (B) Find.
- What is the first purchase order number raised by ECUTRN, Trainer 01? 240

Note: Purchase Order Distributions screen > Number field (usually the lowest PO Number is the first PO created). The Purchase Order Distribution screen is the ones that opens as default when you query by requester.

- How many lines are on PO 240? 7

Note: Scroll down the list to find the highest number in the Line field where the PO Number field = 240.

- When was the item ordered on PO 240 line 4 received? \textit{Trick question! It hasn’t been received yet.}

Note: (M) Inquire > View Receipts.

- Is there an invoice matched to this purchase order? Yes

Note: (M) Inquire > View Invoices.

- If so, what is the invoice number? 10486

Note: (M) Inquire > View Invoices > Invoices field.

- How much is the invoice for? $528.45

Note: (M) Inquire > View Invoices > Invoiced field.

- How much of the invoice has been matched to the purchase order? $480.42

Note: (M) Inquire > View Invoices > Invoiced field.
Note: (M) Inquire > View Invoices > Matched field.

- Why is the invoice total different to the amount matched to the purchase order?

  *Because the purchase order is raised excluding GST, but the invoice is raised including GST. Therefore the difference is due to GST.*

- Has the invoice been paid yet?  
  
  *No*

  Note: (M) Inquire > View Invoices > Last Paid Date or Check Number fields would have data in them if payment had been made already.

- Is the invoice on hold?  
  
  *Yes*

  Note: (M) Inquire > View Invoices > On Hold field.
You should now be able to do the following:

- Perform Requisition Inquiries
- Perform Purchase Order Inquiries
Oracle 11i - Additional Inquiry Features

Chapter 9
Oracle 11i - Additional Inquiry Features
Objectives

After completing this lesson, you should be able to:

- Park a document on the Navigator
- Folder tools
Park a document on the Navigator

If you have a document, such as a particular journal, purchase order or invoice that you want to access later, you can create a link to the document using the Navigator’s Document feature. The Navigator’s Document feature allows you to create as many links as you want and save them in the Documents region of the Navigator window. The links can be represented as icons in the window or may be viewed as a list.

Adding new Documents to the Navigator:
1. Open the document you wish to work on later.
2. (M) File > Place on Navigator.

Opening the Navigator’s Document Region
1. Choose (T) Documents in the Navigator window.
2. Once you create a link to a document, the Document region will open by default when you log on.

To open a Form from the Document Region.
1. Select the document link you want to open.
2. (B) Open or double click it.
**Renaming Documents in the Navigator**

1. Select the document link you want to rename.
2. Choose (B) Rename or double click the label.
3. Enter the new name, then press OK. There is a limit of 80 characters for document names.

**Removing Documents from the Navigator**

1. Select the document link to be discarded.
2. (B) Remove.

Removing the document link from the Navigator has no effect on the actual document. However, if a record such as a purchase order is deleted in the “Enter Purchase Orders” form, the link in our Navigator displays a message letting you know that your link is now invalid.
Folder Tools

A folder is a special tool that can change the way your forms based screen appears. In the example above (the General Ledger Journal Entry screen), you are able to see a customised view of this screen. The Folder icon will appear in the upper-left corner of a folder block. These customised folders can be saved for access every time you open the form.

If you need to constantly move across the page and require the columns to be sorted or require additional information in a form that allows folder tools, please contact the Systems Team who will give you access to the additional functionality in a non-production environment.
After completing this lesson, you should have learned to:

- Save a document on the Oracle Navigator
- Understand Folder tools
Where to from here

- Enrol in your next training course:-
  - eApprovers
  - eJournals
  - iProcurement
  - iAssets
  - Oracle 11i Reporting
  - AR Invoices

- Systems Support from the 10th January 2006
  - Call: 2772
  - Email: mscsystems@ecu.edu.au